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Preface

About this User Guide

This manual makes the use of the TEDfax simple. It provides comprehensive
product information and complete instructions that include plenty of
illustrations to support the text.

Who Should Use This Book

TEDfax is easy to use and only requires familiarity with the hardware on
which you’re going to run TEDfax. An understanding of UNIX principles is
helpful, but not essential.

Note – The TriTeal Enterprise Desktop 4.0 (TEDTM) is based on Common Desktop
Environment 1.0 (CDE) technology. This manual may refer to the desktop as
TriTeal Enterprise Desktop, TED, or simply, the desktop.

How This Book Is Organized

This manual includes the following chapters:

Chapter 1 has an Introduction about TEDfax such as product description,
platform compatibility, and features.
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Chapter 2 is Getting Started and includes a discussion of how to install the
TEDfax.

Chapter 3 Learning TEDfax: A Tutorial provides step-by-step instruction on how
to use TEDfax.

Chapter 4 discusses procedures for Sending Faxes.

Chapter 5 shows Viewing Faxes procedures such as viewing INBOUND and
FAXBOX directories.

Chapter 6 describes Using TEDfax Phonebooks.

Chapter 7 discusses Using TEDfax Queues.

Chapter 8 gives Advanced Topics for system administrators.

What Typographic Changes and Symbols Mean

The following table describes the type changes and symbols used in this book.

In addition, any of the above type changes may appear in bold for additional
emphasis.

Table P-1 Typographic Conventions

Typeface or

Symbol Meaning Example

AaBbCc123 The names of commands, files,

and directories; on-screen

computer output

Edit your .login file.

Use ls -a to list all files.

AaBbCc123 Parameters or variables; replace

with a real value

To delete a file, type rm filename.

AaBbCc123 Book titles, new words or terms,

or words to be emphasized

Read Chapter 6 in User’s Guide.

These are called class options.

You must be root to do this.
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Introduction 1

This User’s Guide includes instructions necessary to configure and use
TEDfax.

Note – Before you begin using the TEDfax software, read this User’s Guide. It
describes how to install, launch and use your copy of TEDfax. Perhaps most
important, this guide has a tutorial to quickly acquaint you with TEDfax’s
essential functions.

Product Description

TEDfax is a powerful, easy-to-use fax software that enables you to send and
receive faxes directly from your UNIX workstation, server, or X terminal,
without ever leaving your desk.

TEDfax allows you to send and receive faxes to/from any fax machine. Faxes
sent by TEDfax have a cleaner appearance than those sent by conventional fax
machines. That’s because while fax machines scan the pages (like a photo-
copier), TEDfax sends the actual digital data, similar to sending data to a laser
printer.

Product Description 1

TEDfax Features 2

Compatibility 3
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With TEDfax, you may compose faxes from a variety of sources: text,
PostScript files, applications, or simply by typing your message in the message
window. A cover page with your company name and logo can even be
included automatically.

You may view the faxes you receive (and those you send) on your computer’s
screen, or you may print them to a laser printer. In fact, you can print faxes
automatically when they are received.

TEDfax Features

The following is just a partial list of TEDfax’s features.

TEDfax is a robust software package, designed to appeal to both novice and
advanced UNIX users. Among TEDfax’s primary features are:

• A Phonebook Database which You Can Share

TEDfax’s Phonebook allows you to save the fax numbers of people that you
send faxes to frequently. You can even build large lists of recipients, and
send a fax to all of them just by selecting a single name from the Phonebook.

• Links to Other Applications.

TEDfax comes with a number of simple filters that, when installed, allow
you to send faxes directly from within other applications, like FrameMaker.

• ICR Autorouting (Sun OS and Solaris 2.3 Platforms Only)

Normally, TEDfax puts the faxes it receives in an “inbound” directory, but
has no way of knowing for which TEDfax user the fax was intended. When
Intelligent Character Recognition (ICR) Autorouting is enabled, however,
TEDfax searches the cover page (of every received fax) for the name of an
TEDfax user. If it finds a user name, it sends the fax directly to that person.

• Email Notification of Important Events.

TEDfax can be configured to send you an Email notification that your fax
was not delivered to the intended recipient’s machine.

• A Command Line Interface
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If you don’t wish to use the Graphical User Interface (GUI), you can use
TEDfax without ever having to use the “user-friendly” interface.
Furthermore, you can use the command line utilities to link TEDfax to
nearly any program that uses a PostScript printer.

The TEDfax user interface is based on CDE/Motif, the most commonly used
UNIX graphical interface. If you’ve never used a CDE/Motif-based program
before, you should consult the tutorials that came with your computer.
CDE/Motif is, by the way, very similar to most other graphical interfaces
you may have used on other computers.

• Shellscript Implementations of Important Features

Many of TEDfax’s features are accomplished through the use of UNIX
shellscripts. If you’re an advanced user, and your company has
requirements that are not met by TEDfax, you can change how TEDfax
works by changing the shellscripts that it uses.

TEDfax Configuration

While it is not necessary to install TEDfax separately from the TriTeal
Enterprise Desktop, there are some configuration issues that should be defined
prior to using or de-installing TEDfax. The configuration should only be done
by a system administrator. You must login as root to be able to access the
FaxAdmin tool.

Note – If you are deinistalling TEDfax please go through the configuration
steps to deselect the system preferences (Figure 1-2, “FaxAdmin Screen,” on
page 4) and to delete the modem configuration from the Install Modems screen
(Figure 1-3, “Install Modems Screen,” on page 6).
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From the Application Manager, open the TEDfax icon by double-clicking on it
and then double-click the FaxAdmin icon. The FaxAdmin icon is shown below
in Figure 1-1

Figure 1-1 FaxAdmin Icon

After you open the icon, the FaxAdmin screen will appear listing several
system preference check boxes. Select or deselect the options listed according
to your system requirements. The choices availabe are for email options,
printers, and auto-restart.

This screen is shown below in Figure 1-2.

Figure 1-2 FaxAdmin Screen
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Detailed descriptions of these checkboxes are listed below:

Email->Fax Gateway. By default this is checked.   When checked,
this will add an entry in /etc/aliases and
run newaliases to make the entry visible to
the system.   This will allow users to send
email to 'fax' and have that Email filtered
through TEDfax to a remote fax machine.

lp or lpr -> fax gateway. By default this is checked. When checked,
this will add an entry to /etc/printcap or
install a printer model in /etc/lp/model
or /var/spool/lp/model which will allow
users to treat TEDfax as a 'fax printer'.   Jobs
can be sent via lpr or lp requests and their
output sent to a remote fax machine through
TEDfax.

Auto-Restart daemons on reboot. By default this is checked. When checked this
will add an entry to /etc/rc.local,
/etc/rc2.d, or /etc/rc to cause the
TEDfax daemons to restart when the system
reboots.

1. Click on the button labeled Install Modems...
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The Install Modems screen will appear, as shown in Figure 1-3.

Figure 1-3 Install Modems Screen

It is important the you enter the area code and fax number with area code for
you fax modem. It is also important that you enter a valid device name for
the fax modem. The default entry for the first TEDfax modem should be
called “modem1” and should have a spool directory named “Any.”

2. Fill out the empty fields within the Install Modems screen. The fields are
described and listed below:

• Modem Name: name of modem (unique and REQUIRED),

• Area Code: (typically a 3 digit AC) - REQUIRED,

• Number: (typically AC+PHONE#) - REQUIRED,

• Pre-Dial: (a pre-dial string such as 9,) OPTIONAL,
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• Post-Dial: (a post-dial escape code) OPTIONAL,

• Device: (device name where modem lives) REQUIRED,

• SubDirectory: (directory name for outbound fax management and for
'modem1', must be Any) REQUIRED.

3. Click on the OK button.

The serial device file will be chown-ed to root. The serial line will become
a dedicated fax line.

You’ll be returned to the FaxAdmin screen again.

4. Click on the button labeled Start Server...

The Start Server screen will appear, as shown below in Figure 1-4.

Figure 1-4 Start Server

5. Click on the Start Server button.

Be patient. The first thing that TEDfax will try to do is to talk to the server
on the current host to make sure that one isn't already present. It may take
some time (up to a minute) for this connection to fail. A status of what
TEDfax is doing is displayed at the bottom of the start server popup.

If all goes well, the “status” field will change from “Unable to connect” to
“connected.” You may now exit the FaxAdmin tool. TEDfax is now ready for
use.
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Starting TEDfax

To start TEDfax, locate the TEDfax icon in the Application Manager. It is
shown below in Figure 1-5.

Figure 1-5 TEDfax Icon

Double-click the TEDfax icon. This will open up the TEDfax directory and list
the available options: EditFax, FaxAdmin, FaxBook, FaxQueue, SendFax, and
ViewFax. The TEDfax Application Manager is shown below in Figure 1-6.

Figure 1-6 TEDfax Applications

From this location, you can access all of the features of TEDfax. For more
information on using TEDfax please see Chapter 2, Learning TEDfax.



9

Learning TEDfax 2

This chapter explains how to use TEDfax’s fundamental features. It is TriTeal’s
belief that examples are among the best tools for learning. Therefore, the
procedures in this chapter are presented within a step-by-step tutorial that uses
a lot of examples. For instance, you’ll be instructed to send a fax to yourself.
Feel free to send a fax to anyone you wish instead of actually using the exact
example items presented.

The method of using TEDfax’s menus, screens, and fields is consistent
throughout all aspects of TEDfax; once you know how to use the send feature,
you’ll be capable of exploring all features that TEDfax offers.

Note – To learn TEDfax, this chapter should be read from beginning to end
without any interruptions. It will take approximately 20 minutes to learn how
to send and receive faxes using TEDfax.

Sending Faxes

This section will familiarize you with using TEDfax’s buttons and menus as
well as how to send a fax. Follow these instructions to send a fax:

Sending Faxes 9

Viewing Received Faxes 14

Using TEDfax Phonebooks 16
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1. Locate the SendFax icon in the TEDfax folder in the Appliction Manager. It
resembles the icon shown below in Figure 2-1.

Figure 2-1 The SendFax Icon

2. Open the SendFax icon, by moving the mouse cursor over it and double-
clicking the left mouse button.

If this is the first time you run any of the TEDfax clients, it is likely that you
will not have a .faxrc file in your home directory. This is the file which contains
your personal TEDfax settings and information. TEDfax will notice this and
popup the GUI panel to ask if you would like to create this file. The Startup
Error dialog box is shown here in Figure 2-2.

Figure 2-2 The Startup Error Diaolog Box
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Enter the hostname of your fax server and password assigned to that fax server
and click on the “create file” button. By default there is no password assigned
to your fax server so you can just leave this field blank. At this point reselect
the SendFax icon to continue with the tutorial.

After a brief wait, the Send Screen will appear, as shown here in Figure 2-3.

Figure 2-3 The Send Screen

The Send Screen

The Send Screen has four primary fields which are listed below:

From Specifies the person sending the fax (typically you).

To Specifies the person who will receive the fax.

Message Specifies a subject and message to appear in the fax. This will
usually appear on the fax’s cover page.
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Attach Specifies any files you wish to send along with the fax.

Sending a fax is straightforward. You move to each field within the send screen
by clicking on it with the mouse, or by using the tab key. Then you simply
enter the appropriate text using the keyboard.

From Fields

If this is the first time you’ve used TEDfax, the From fields will probably be
blank. The cursor will be blinking in the from field. The following steps guide
you through using the From portion of the Send screen. When typing phone
numbers, you may omit the
“-” or “()” characters (or use them); TEDfax will ignore the “-” and “()”
characters between digits.

1. Type your name. Press the <Tab> key. This will forward the cursor to the
Company field.

2. Type your company name. Press the <Tab> key. This will forward the cursor
to the Phone field.

3. Type your phone number. Press the <Tab> key. This will forward the cursor
to the Fax field.

4. Type the fax number.

5. Using the left mouse button, select Save As User from the From menu. The
button marked From is actually a menu. Your information will now appear
automatically, every time you open the Send Screen.

That’s all there is to using the From portion of the Send screen. The following
steps will show you how to use the To portion of the Send screen.

To Fields

In this portion of the tutorial, you’ll be sending a fax to yourself so you can
easily verify the accuracy of this exercise:

1. Move the mouse cursor over to the To field and press the left mouse button.

2. Type your name. Press the <Tab> key. This will forward the cursor to
Company field.
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3. Type your company name. Press the <Tab> key. This will forward the cursor
to Phone field.

4. Type your phone number. Press the <Tab> key. This will forward the cursor
to Fax field.

5. Type your fax number.

6.  Press the <Tab> key. This will forward the cursor to the Subject field.

7. Type “This is a test fax”.

8. Using the left mouse button, select Save To Phonebook from the To menu.
The button marked To is actually a menu. A dialog window, as shown
below in Figure 2-4, will appear.

Figure 2-4 Save To Phonebook Dialog Box

9. Move the mouse cursor over the Save button and press the left mouse
button.
The information in the To portion of the Send screen will automatically be
saved in your Phonebook for future use. We’ll discuss the Phonebook later
on in this tutorial.

10. Press the Send Fax button at the bottom of the Send screen.

That’s it, your fax is on its way.

Note – Your fax will not be sent until you press Send Fax. If you close the Send
Screen, by pressing Done in the File menu, without first pressing Send Fax,
your fax will not be sent, and the information you entered will be lost.

That’s enough about sending faxes for now. The Send Screen has many
features we haven’t explored, but that will be done later in this Guide.
You’re welcome to experiment as you already possess the skills necessary to
navigate through TEDfax’s easy to use screens.
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11. Move your cursor to the File menu, press the left mouse button and select
Done.

This will close the Send screen.

Viewing Received Faxes

TEDfax allows you to view faxes that have been received. To find out what
faxes have been received by TEDfax, you just select the ViewFax icon in the
TEDfax folder in the Application Manager.

1. Locate the ViewFax icon in the TEDfax folder in the Application Manager. It
resembles the icon shown below in Figure 2-5.

Figure 2-5 ViewFax Icon

2. Open the ViewFax icon, by moving the mouse cursor over it and double-
clicking the left mouse button.
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The View Screen, as shown in Figure 2-6, will be displayed. As you’ve just
installed TEDfax, the list of faxes will probably be empty.

Figure 2-6 The View Screen

Although we’re not going to perform in-depth examples of how to use the
View screen, as we did with the Send screen, it’s important that you know how
to view incoming faxes. When TEDfax receives a fax, it is placed in a file
located in an inbound spool directory.

Faxes received by TEDfax are stored in an inbound directory, typically
/usr/spool/TEDfax/inbound.   Each user also has a private faxbox
directory, typically $HOME/faxbox, in which faxes which have been
forwarded to that user will be stored. The View Screen shows you a list of the
faxes in this directory.

The buttons at the bottom of the screen perform actions on the faxes. We’ll
explain them all in detail later in this Guide. To use these buttons, select one or
more faxes from the list as you would when using the File Manager. Then,
press the button for the desired action. For example, Print to print the faxes to
a printer, or View to view the fax on your computer’s screen.
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Updates to the View Screen

The view screen displays the faxes in the currently selected directory from the
time the view screen was last told to update or when it was first displayed. If a
new fax is added to a directory which the View screen has already displayed,
the faxes listed in the view screen might not include the new fax. There are
several ways to force the View screen to re-scan the directory and update the
list of faxes stored there:

• Use QuickKeys to re-select a directory. This will force it to be re-scanned,

• Double click on the “.” entry shown in the directory listed,

• Move the mouse into the text field displaying the current directory name
and hit <return>.

Using TEDfax Phonebooks

Often TEDfax users send faxes to the same people, or group of people. To save
time, TEDfax has a built in Phonebook that will store these frequent fax
recipients. After you add these people to your Phonebook, you don’t have to
type these fax numbers again; TEDfax will do it for you, automatically. You can
also create Phonebook entries that contain lists of people. This feature allows
you to send a fax to many people, just by selecting a single Phonebook name.

1. Locate the FaxBook icon in the TEDfax folder in the Application Manager. It
resembles the icon shown here in Figure 2-7.

Figure 2-7 The FaxBook Icon

2. Open the FaxBook icon by moving the mouse cursor over it and double-
clicking the left mouse button.
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The Books screen, as shown below in Figure 2-8, will be displayed.

Figure 2-8 The Books Screen

The top part of the screen is a list of everyone in the phonebook. That’s
referred to as the Phonebook List. The name of the phonebook being
displayed is at the top of the list. You may have as many phonebooks as you
want, but there will just be two when you first install TEDfax: Your Private
Phonebook, that only you normally have read and write access to, and the
Server Phonebook, that everyone can read. Toggle between these two
Phonebooks as follows:

♦ Press the Phonebook button (it is likely displayed as My Phonebook), by
moving the mouse cursor over it and pressing the left mouse button.

The available Phonebooks are displayed.
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The bottom part of the screen displays the information about the person who is
currently selected in your Phonebook List. To view the information about
someone else, you’d simply click on their names in the Phonebook List, using
the left button on your mouse.

Adding People to a Phonebook

You added yourself to the Phonebook earlier in this tutorial when you were
learning how to send faxes. Let’s add an imaginary person (or you may add
the name of a real person if you wish) to solidify your use of the Phonebook.
First, decide which phonebook you want to add the person to, and select that
Phonebook as follows:

1. Press the Phonebook button (likely is displayed as My Phonebook), by
moving the mouse cursor over it and pressing the left mouse button.

The available Phonebooks are displayed. Be sure you select your private
Phonebook, to which you have write permission, before trying to add a new
name.

2. Locate the area of the Book screen that lists the Name, Company, Phone, and
Fax fields.

3. Click on the Name field.

4. Type “Gary Marton.” Press the <Tab> key. This will forward the cursor to
the Company field.

5. Type “Marton Enterprises.” Press the <Tab> key. This will forward the
cursor to the Phone field.

6. Type “(555) 555-5555.” Press the <Tab> key. This will forward the cursor to
the Fax field.

7. Type “(555) 555-5555.”

You can continue tabbing your way through the fields to add the
information you feel is necessary.

8. Using the left mouse button, select Save As New at the bottom of the screen.

The person’s name will now appear in the Phonebook List, and will appear
every time you open the Books screen.
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Removing People from a Phonebook

To remove a person from a Phonebook, just click on the person’s name in the
Phonebook List and select Remove Person from the Edit menu. The person will
be deleted from the phonebook. In the following example, we’ll remove our
imaginary person, Gary Marton, from the Phonebook. Proceed as follows:

1. Move the mouse cursor over Gary Marton and press the left mouse button.

2. Select Remove Person from the Edit menu.

Gary Marton is now deleted from the Phonebook.

Adding Lists to a Phonebook

TEDfax also allows you to create lists of people. For example, you may create a
list of all your branch offices, so that you can send a fax to all of them with the
click of a single button. To view the lists in a phonebook, press the Lists toggle,
located just below the Phonebook List.

Move the mouse cursor over Lists and press the left mouse button.

The Phonebook List will now display all the lists contained in the selected
phonebook.
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The bottom of the screen shows information about the list currently selected in
the Phonebook List. Most likely, you don’t have one yet. This section will
present general procedures. Phonebook Lists will be explained in Chapter 5,
Using TEDfax Phonebooks. The Books Screen which with the “Lists” toggle
button selected is shown below in Figure 2-9.

Figure 2-9 The Books Screen Lists Toggle

On the left is the Name of the current list, and a list showing everyone who’s
within the current list. To the right is a list of all the people in the current
phonebook. To add a person to a list, click on the person’s name in the Name
list, and press the Arrow button t move that person into the List Contents. You
can add both people and other lists to your list. You can only add things from
the currently selected phonebook (not from other phonebooks).

The Save As New button is used to save your addition to the Phonebook List.
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Sending Faxes to People and Lists

To show you how to send faxes to people and lists, a general discussion is
presented in this section. Phonebook Lists will be explained in detail later in
this Guide.

To send a fax to a person or list of people, just select the person’s name from
the Phonebook List and press Send To. It resembles the button shown.

The Send Screen will appear and the person or list will be added to the To
region. You can add as many people as you want this way. The To region of the
Send Screen becomes a list, and all the people you’ve added will appear within
that list. When you press the Send Fax, the fax will be sent to all of them.

You can more easily add groups of people by clicking the Destinations button
in the Send Screen. The Destinations button is shown here.

A miniature version of a Phonebook screen will appear, with an arrow button
to allow you to add people and lists to your list of destinations. We’ll explain
this in more detail later. To return to your original view of the Send Screen,
press the Overview button.

To close the Books Screen, select the Done button from the File menu.
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The Send Screen allows you to create and send faxes. You can send a fax to one
person or to many people, at one time. A fax can consist of a typed message as
well as attached files.

To send a fax, you’ll simply click on the SendFax icon, type in the recipient’s
information, and click the SendFax icon.

1. Locate the SendFax icon in the TEDfax folder in the Application Manager. It
resembles the icon shown in below in Figure 3-1.

Figure 3-1 The SendFax Icon

2. Open the SendFax icon, by moving the mouse cursor over it and double-
clicking the left mouse button.
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Send Screen Structure

The Send Screen is made up of several components which are shown below in
Figure 3-2.

Figure 3-2 The Send Screen

At the top of the screen is a standard Motif menubar, containing the File, View,
and Help menus.

Below that are the View Buttons, marked Overview, Destinations, Message,
Attach, and Options. They display different views of the same information; in
other words, the views are comparable to different windows looking at the
same information. The views have no effect on the fax data. Go ahead and click
on the different View buttons if you wish, but press the Overview button to
return to the default screen.

Below the view buttons is the main input area (the view input area varies
according to the view you have selected). This is where you specify
information about the fax.
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When you are done composing your fax, press the Send Fax button to send it
on it’s way.

Note – Your fax will not be sent until you press Send Fax. If you close the Send
Screen, by pressing Done in the File menu, without first pressing Send Fax,
your fax will not be sent, and the information you entered will be lost.

The Input Area

When you first open the Send Screen, the input area will display four distinct
regions:

From Specifies the person sending the fax (typically you).

To Specifies the person who will receive the fax.

Message Specifies a subject and message to appear in the fax.
This will usually appear on the fax’s cover page.

Attach File... Specifies any files you wish to send along with the fax.

Sending a fax is straightforward. You move to each field within the send screen
by clicking on it with the mouse, or by using the tab key. Then you simply
enter the appropriate text using the keyboard and/or use the appropriate
menus.

Send Screen Views

The default screen shown is the Overview view of the Send Screen. While it’s
the view you will use most commonly, the Send Screen has several ways to
display your fax’s information. You can select between these different views
(Overview, Destinations, Message, Attach, and Options) by selecting the desired
View Button, or from the View menu in the menubar. The two methods do
exactly the same thing.

Each of the views changes the input area to display different information about
your fax, as listed below:

Overview The “default” view that you will use most often. This
was the view you explored in the tutorial, containing
the From, To, Message, and Attach regions.
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Destinations Displays a list of the people who will receive the fax.
This view is simply a larger version of the To region.

Message Displays the subject and message for the fax. This view
is simply a larger version of the Message region.

Attach Displays a list of the files to be sent with the fax. This
view is just a larger version of the Attach region.

Options Displays advanced options for the fax.

The Overview View

The Overview view is the what you’ve used so far in this guide. This view is
made up of four regions: From, To, Message, and Attach.

The “From” Region

The From region displays who the fax is from. This information usually will
appear on the coverpage of the fax. Typically, the fax is from you, so your
name and information should appear in the Name, Company, Phone and Fax
fields.

By holding down the left mouse button on the From menu, you’ll see the
functions listed below.

Revert To User Changes the information displayed in the From region
to whatever values you’ve previously saved using Save
As User.

Save As User Saves what you’ve entered in the From region as your
“default” values. These are the values that
automatically appear whenever you open the Send
Screen.

Clear All Clears the fields in the From region. By selecting Clear
All, each field will be blank.

The “To” Region

The To region displays who the fax should be sent to. When you first open the
screen, this region will display four fields, just like the From region. You may
enter the information of the recipient of the fax in this region. This is referred
to as the single-destination mode.
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It is also possible to specify the destination of a fax by using the Send To
button of the Books Screen. From the Books Screen, you can send to one or
many recipients in a list. This is referred to as the multiple-destinations mode.
Refer to Chapter 5, Using TEDfax Phonebooks, for detailed information.

By holding down the left mouse button on the To menu, you’ll see the
functions listed below.

The To menu contains the following functions when it’s in “single-destination”
mode:

Find By Name Attempts to find a name in your Phonebooks that
matches the name you’ve entered in the name field,
and enters that person’s information into the To region.
You can even specify a partial name, or even a single
letter. Press this button repeatedly to find other
possible matches.

Save To Phonebook Saves the person and information you’ve entered into
your Phonebook. A new Phonebook entry is created.

Clear All Clears the fields in the To region.

When in “multiple-destinations” mode (adding destinations using the Send To
button of the Books Screen) the To menu has these functions:

Clear Selected Removes any selected person(s) from the list of
destinations. To select or unselect a person, click on the
person’s name.

Clear All Removes everyone from the list of destinations.

The “Message” Region

The Message region contains a subject and message to be printed on the fax.
Usually, this information is printed on the coverpage of the fax, but you can
change its printing location using the Options view.

The message can be as long or as short as you desire. If it’s too long to fit on
one page, TEDfax will divide it into several pages. The Message area is always
80 characters wide, so that standard UNIX text files fit comfortably.

The message can originate from a file “dragged” from the File Manager onto
the message text area or a selected text buffer “dragged” from another
application.
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By holding down the left mouse button on the Message menu, you’ll see the
functions listed below:

Load Text Loads any standard text file into the Message textfield.
A file browser pops up to allow you to choose a file to
load.

Save Text Saves the message you’ve entered as a text file. A file
browser pops up to allow you to enter the desired
name of the file.

Clear Message Clears the Message text field.

The “Attach” Region

The attach region displays any files you’ve attached to your fax. The files will
appear as icons in the Attach window.

TEDfax recognizes FrameMaker, Sun Raster, text, TIFF and PostScript files (and
can be configured to recognize most other file types). Ask your TEDfax
administrator to install other file types, if necessary. A copy of each attached
file will be “rendered” into fax format (TEDfax TIFF) and sent along with your
fax. The original files themselves will not be changed in any way.

These files may be attached via “drag & drop” from the File Manager onto the
attached file’s scrolled window.

The Attach menu contains the following features:

Attach File... Attaches a file. A file browser pops up to allow you to
choose the files to attach. To select one or more files,
select files as you would using the File Manager and
either drag them to the attachment area or select the
“Attach File” button.

Clear Selected Removes any selected files from the list of attached
files.

Clear All Clears all attached files.

Move Selected Left Moves the selected file left, so that it’s attached before
the files to its right.

Move Selected Right Moves the selected file right, so that it’s attached after
the files to its left.
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The Destinations View

The Destinations view displays the list of people you wish to receive your fax
and allows you to add people, or lists of people, from your phonebooks. When
building a large list of people, it tends to be easier to use than the Overview
view. The Destinations button is shown here.

To use the Destinations view, press the Destinations button at the top of the
screen, or select Destinations from the View menu.

The Destinations view is shown below in Figure 3-3.

Figure 3-3 The Destinations View Screen

The Message View

The Message view displays the subject line and message to be printed on a fax.
This view is identical to the Message region of the Overview view, it’s just a
little bigger. Sometimes it’s easier to use.
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To use the Message view, press the Message button at the top of the screen, or
select Message from the View menu. The message can originate from a file
“dragged” from the File Manager onto the message text area or a selected text
buffer “dragged” from another application.

The Attach View

The Attach view displays the list of files you’ve attached to your fax. It
displays the same information as the Attach region of the Overview view, but
in a slightly different way. It tends to be easier to use than the Overview view
when working with large lists of files.

To use the Attach view, press the Attach button at the top of the screen, or
select Attach from the View menu. The Attach view is shown below in
Figure 3-4.

Figure 3-4 The Attach View Screen
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On the left side of the screen is the list of attached files. On the right is a file
browser. To add a file to the list of attached files, select it’s name from the file
browser, and press the Arrow button or you can drag them to the list of
attached files.

Clear Selected Removes any selected person(s) from the list of
destinations. To select or unselect a person, click on the
person’s name.

Clear All Removes everyone from the list of destinations.

Files can be attached via “drag & drop” from the File Manager onto the
attached file’s scrolled window.

The Options View

The Options view contains TEDfax’s advanced options for sending faxes. The
Options Screen is shown below in Figure 3-5.

Figure 3-5 The Options View Screen
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The values in this screen are reset to their default values every time you open
the Send Screen. Use the Options menu (between the Overview button and the
“Use Modem:” field) to change these default values, and to return to them.

Revert To Saved Changes the values in the Options view to their default
values.

Save As Default Saves the current values as the “default” values. In
other words, the values that automatically appear
whenever you open the Send Screen.

Keep in mind that Save As Default always saves the value of every option in
the Options view. Make sure that all options on the screen are exactly how you
want them.

Choosing Which Modem to Use

You can specify which modem you want to use by selecting it from the Use
Modem: menu. TEDfax allows each modem to have a name of your choosing:
the names of your modems were picked by the person in your company who
installed TEDfax.

If you want the selected modem to be used as the default modem; that is, the
modem that will be used for all faxes you send unless you specifically choose
another, you must save your change as the default value using Save As Default
from the Options menu. If you don’t, your change will only be in effect until
you close the Send Screen.

Specifying Retry Counts

When TEDfax can’t deliver a fax, because the line is busy, the other fax
machine wasn’t working correctly, or for other reasons, it will try again. How
many times it will continue to try is called the Retry Count.

To change the retry count, type the desired number into the Max. Retries field.

To change the amount of time TEDfax will wait before trying again, type the
desired number (in minutes) into the Retry Delay field.

Remember, if you wish your changes to take effect for all faxes you send, you
must save your changes as the default values using Save As Default from the
Options menu. If you don’t, your changes will only be in effect until you close
the Send Screen.



34 TEDfax User’s Guide

3

The Hold on Failure “checkbox” will keep a fax in the queue even if the send
fails, after reaching the maximum retry count.

Setting Email Notifications

TEDfax can, at your option, send you Email when a fax is successfully
transmitted, or when a problem has prevented the fax from being sent. These
are very useful features, and are strongly recommended by TriTeal.

The three notification options are marked Success, Retries, and Failure. They
are enabled by pressing the checkbox next to them so that it appears
“checked.” Usually, a “checked” box will appear pressed and display a check
mark over the box.

When you turn on one of these features, use the textfield to the right of the
option to specify an Email address. Usually, you should put your own address.
An example of an Email address is “smith@mycompany.com”.

Success Send Email to the specified address when a fax is
successfully transmitted.

Retries Send Email to the specified address when a fax
transmission has failed, but TEDfax will try again.

Failure Send Email to the specified address when a fax
transmission has failed, and TEDfax will not try again,
because the Retry Count has been “used up.”

Note – Note that all email sent by TEDfax is sent via the shell script
/usr/dt/fax/bin/TEDfax_sendmail. All notification is sent via the shell
script /usr/dt/fax/bin/TEDfax_notify. Fax administrators may change
the behavior to success, notify, and retry by editing these shell scripts.

If you wish for your changes to take effect for all faxes you send, you must
save your changes as the default values using Save As Default from the
Options menu. If you don’t, your changes will only be in effect until you close
the Send Screen.
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Documenting A Fax Transmission

Your company may desire, or even require, some documentation of faxes that
are sent, and when they are sent. TEDfax provides three “levels” of
documentation. You may use all, some, or none.

To enable each option, click in the checkbox next to it so that the box appears
“checked.” Use the textfields to the right to specify the additional information
each option requires.

Make Log Entry TEDfax will make a brief note in a special text file
called a log file, documenting when the fax was sent,
who it was sent to, and who sent it. Use the textfield to
specify the full name and path of the file to use. If it
does not exist, it will be created.

Print Copy TEDfax will print a copy of the fax to the printer you
specify in the textfield. (To automatically print all
incoming faxes, run TEDfax as user root (or fax
administrator), select this option, and save as default.)

Save Copy TEDfax will save a full copy of the fax to the directory
you specify in the textfield. Because faxes are large, this
takes quite a bit of disk space. It is, however, helpful
for some companies.

If you wish for your changes to take effect for all faxes you send, you must
save your changes as the default values using Save As Default from the
Options menu. If you don’t, your changes will only be in effect until you close
the Send Screen.

Choosing a Coverpage

TEDfax allows you to create your own coverpages, and to use different
coverpages with different faxes.

Each coverpage is a PostScript file with special “flags” that TEDfax knows to
replace with, for example, the name of the person sending the fax, or the
message that’s supposed to appear.

The Place Message On Coverpage checkbox controls (you guessed it) whether
the message you typed for the fax appears on the coverpage, or not. If this box
is unchecked, the message will always appear on a separate page by itself, just
after the coverpage.
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Each coverpage is given a name of your choosing. To select a coverpage to
send with your fax, select the name of the coverpage from the Coverpage
menu.

If you wish to use a certain coverpage as the default coverpage for all faxes
you send, you must save your change as the default value using Save As
Default from the Options menu. If you don’t, your change will only be in effect
until you close the Send Screen.

Creating Custom Coverpages for Your Company

To automatically generate a coverpage with your company’s name on it, select
Create Coverpage from the File menu of the Send Screen. The Create
Coverpage window is shown here in Figure 3-6.

Figure 3-6 The CreateCoverpage Window

In the dialog that pops up, you’ll need to fill in the following information.

Coverpage Name The name you want to give this coverpage, that will
appear in the Coverpage menu.

Filename The desired full path and filename for the coverpage.
This is where the coverpage file will be created (for
example, /var/dt/fax/data/mycover.ps).

Company Name The name of your company, as you want it to appear
on the coverpage. You don’t actually have to put your
company’s name; you could put a title like “From the
desk of Bob Smith” on your coverpages instead.

Press Create to actually create the new coverpage file and add it to your menu
of coverpages. Press Cancel to close the screen without creating a coverpage.
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TEDfax Coverpages are stored as PostScript files which may contain macro
strings.   The PostScript file thus acts as a template coverpage. The macros are
substituted as each fax coverpage is to be generated, the PostScript is rendered
into a fax ready image, and that image is sent out. Chapter 8, Advanced Topics
contains information on how to create such custom postscript template
coverpages on your own.   However, to simplify matters, TEDfax has a simple
means of modifying its default coverpage to contain your company name.
This allows most users to avoid the task of creating a coverpage by hand.

Installing Coverpages from Other Applications

You can use other applications to create your own coverpage files. TEDfax
coverpages are PostScript files that contain macro strings. TEDfax knows to
look for these strings and replace them with the relevant information.

To install these coverpages, once they’re created, into your Coverpages menu,
select Customize Coverpages from the File menu of the Send Screen. The
Customizer window is shown below in Figure 3-7.

Figure 3-7 The Customize Coverpage Window

The list in the center of the screen is your current list of coverpages. To change
an entry, click on it in the list, make your modifications in the textfields below,
and press Change. To delete an entry, click on it, and press Remove. To add a
new entry, enter the information into the textfields, and press Add.
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To add a coverpage created from another application, just type the name of the
coverpage, and its path and filename, and press Add.

Previewing a Fax Before You Send It

Frequently, it is useful to have a look at a fax before you press Send Fax, just to
make sure what you are sending is what you think you’re sending. This is
referred to as previewing a fax.

To preview a fax, select Preview from the File menu.

If you haven’t yet specified enough information about your fax for TEDfax to
determine how it will look, you might get an error message telling you what
else is required. Typically, the View/Edit Screen will pop up, with an image of
your fax.

We’ll see how the Editor works later. For now, you should just know the basics.

• The Arrow buttons at the bottom let you change which page you’re
viewing,

• The View menu lets you look at the fax in different ways, and

• The Done button, in the File menu, closes the screen.

Since you’re looking at a read-only copy of your fax, you won’t be able to
make any changes to it using the editor. If you make changes to the fax using
the Send Screen, for example, changing the attached files, you’ll have to close
the Editor screen and press Preview again to look at your changes.

Select Done from the File menu to close the Editor Screen.

Printing a Fax

Printing a copy of your fax is straightforward. Just select Print from the File
menu. Enter the name of the printer, if necessary or you may drag a “received”
fax to the printer icon.

Sending the Fax, An Advanced Explanation

At this point, you already know how to send a fax. This section describes what
TEDfax does after you press the Send button. You don’t need to read this
material to use TEDfax, but it is helpful for administrators and advanced users.
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First, TEDfax attempts to render the fax and any files attached to the fax, into
fax format (TEDfax TIFF). The resulting fax “picture” is then sent to the
TEDfax fax server, where it is placed in a queue.

Each modem TEDfax uses is attached to a separate process, called a faxmodem
process. Each process scans its queue for faxes to be sent, and controls the
modem during transmission and receipt of faxes.

If a modem has many faxes to send at the same time, or has to send the same
fax to an entire list of people, it obviously can’t call them all at once, so each
faxmodem process handles each fax one at a time. Sometimes, a group of
modems will use the same queue. In this case, they can “team up” by sending
faxes to different people at the same time.

This means that a fax might not be sent as soon as you press Send Fax. You
might have to wait for the faxmodem to finish sending other faxes first. If
you’ve set a delay time for the fax, using the Send Screen’s advanced options,
be aware that the time you enter is the time the fax will be placed into the
queue. It may not be sent at that exact time, if other faxes need to be sent first.

If it’s taking too long to send a fax, because your company sends lots of faxes,
you should connect more faxmodems to your network to speed things up.
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Viewing Faxes 4

The View Screen allows you to look at and manipulate received faxes. You’ll
find this to be a powerful method of reading faxes.

To view a fax, you’ll simply double click the ViewFax icon in the TEDfax folder
in the Application Manager and select the fax.

Being Notified When Faxes Arrive 44

Managing Received Faxes 43

The View Screen Action Buttons 46

Viewing INBOUND and FAXBOX 45

Viewing and Editing Received Faxes 47

Forwarding Faxes to Other Users 47

Navigating the Filesystem 49

Using Faxes with Other Applications 49

Customizing the QuickKeys Menu 51
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1. Locate the ViewFax icon in the TEDfax folder in the Application Manager. It
resembles the button shown below in Figure 4-1.

Figure 4-1 The ViewFax Icon

2. Open the ViewFax icon, by moving the mouse cursor over it and double-
clicking the left mouse button.

The View Screen, shown here in Figure 4-2, is made up of several distinct areas.

Figure 4-2 The View Screen
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View Screen Structure

At the top of the screen is the standard Motif menubar, with the File, Help, and
two other useful menus we’ll explain later.

Below that is your list of faxes. This is actually a file browser, that
automatically opens to the directory to which received faxes are sent.

At the bottom of the screen are the action buttons. To perform an action on one
or more faxes, select them from the browser (as you would in the File
Manager), then press one of the buttons.

How TEDfax Receives Faxes

In Chapter 3, we described what happens when TEDfax receives a fax. Before
explaining the features of the View Screen, the following paragraphs will
refresh you on incoming faxes. You’re encouraged to re-read the section of
Chapter 3 titled, Viewing Received Faxes before continuing.

There are two directories TEDfax uses to store your received faxes. When a fax
is received from a faxmodem, it’s put into the INBOUND directory, typically
/usr/spool/TEDfax/inbound. Because fax machines don’t tell TEDfax who
a fax is for, all received faxes are put into this location.

The other directory is your FAXBOX directory. The FAXBOX directory is your
own private mailbox, where faxes go when TEDfax knows the fax is for you.
This is also where faxes are sent when other users forward them to you. Every
user has their own FAXBOX directory, typically, $HOME/faxbox.

Managing Received Faxes

To use TEDfax most effectively, your company needs to decide how it wants to
manage the receipt of faxes. Will one person be in charge of forwarding faxes,
or will users look through all the faxes themselves? How do you and your
fellow users want to be notified when a fax comes? Do you want to print the
fax to a printer when it is received? TriTeal strongly recommends that you start
by configuring TEDfax to automatically print all received faxes to a nearby
printer.

Small companies, or small groups of people in large companies, may be well
served by many options. Many larger organizations decide to either assign
someone the task of looking at and forwarding faxes, or configure TEDfax to
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automatically print all received faxes to a nearby printer. Your own decision
will probably be based on how many faxes you receive during the day, and
how many different people usually receive them.

You also should consider using ICR Autorouting (only available on SunOS 4.1.x
and Solaris 2.3 platforms) to automatically forward faxes to users. When this
option is enabled, TEDfax will look on the first page of received faxes for the
names of people in your company. If it finds one, it forwards the fax to that
person.

Regardless of what your company decides, you almost certainly want TEDfax
to send you Email or some other notification when you receive a fax. Think
carefully before turning this feature off.

Being Notified When Faxes Arrive

You may select how you want to be notified when faxes are sent to you by
selecting Options from the File menu of the View Screen. This opens the View
Screen Options window, shown below in Figure 4-3.

Figure 4-3 The View Screen Options Window

The topmost field, marked Inbound Fax Directory, specifies the directory where
received faxes are placed. You probably shouldn’t change this directory
without good reason.
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The other options control what happens when a fax is received. To enable an
option, press the checkbox next to it so that it appears “checked,” and enter
any required information into the textfields.

ICR Autoroute Attempt autorouting when a fax is received. This
option is only used by the TEDfax administrator. For
regular users, ICR Autoroute is ignored.

Beep At Me Makes a “beep” sound at the last terminal you’ve used
when a fax is received, but only if you’re logged in at
the time.

Email User Sends Email to the specified user address when a fax is
received.

Print Copy Prints each received fax to the specified printer. TriTeal
strongly recommends enabling this notification feature.

Run Filter Runs the specified shellscript on each received fax. The
full path of the received fax is appended.

To save your changes, you must press the Apply button. The Reset button will
reset each option to its saved value. To close the screen, press OK.

Viewing INBOUND and FAXBOX

When you first open the View Screen, the contents of your private FAXBOX
will be displayed.

To switch between viewing the INBOUND (/usr/spool/TEDfax/inbound)
and FAXBOX ($HOME/faxbox) directories, use the QuickKeys menu.
Remember, INBOUND contains faxes received from the faxmodems. FAXBOX
contains faxes that other users or ICR Autorouting have forwarded to you.

The QuickKeys menu is just a list of important directories. Use it to quickly
move to directories you’re interested in. Usually, this will be limited to
INBOUND and FAXBOX, but you can add other directories by selecting
Customize QuickKeys in the File menu.
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The View Screen Action Buttons

Once you’ve received a fax, you most likely want to do something with it. The
action buttons at the bottom of the screen perform useful functions. To use
them, select a fax from the browser, and press the desired action button. The
action buttons work as follows:

Rename Allows you to change the filename of the fax to
something more descriptive and useful, or to move the
fax to some other directory.

Remove Permanently deletes the fax.

Print Prints the fax to a printer. You should enter the name of
the desired printer into the dialog box that pops up,
along with any other options you desire.

View Displays the fax on your computer screen using the
TEDfax Editor.

Forward Forwards the fax to another TEDfax user.

Each of these buttons has an identical entry under the File menu, for your
convenience. The File menu also contains an entry called New.

New Creates a new, empty fax and opens the TEDfax Editor
to allow you to edit it.
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Viewing and Editing Received Faxes

To have a fax displayed on your computer’s screen, select the fax from the list
and press the View button. You may also just double-click on the list entry. To
test this feature, select any fax; the fax below is simply an example. The Edit
window is shown below in Figure 4-4.

Figure 4-4 The View Screen Edit Window

Using the editor is straightforward. You can use the Arrow buttons at the
bottom to view different pages, and the View menu to view the fax at different
scales and orientations. As the editor is so simple to use, TriTeal encourages
you to explore the editor and discover the rest of its useful features.

To close the Editor, select Done from the File menu.

Forwarding Faxes to Other Users

If you want to let another user know that a certain fax needs attention, you
should forward the fax to that user.
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Forwarding a fax places a copy of the fax in the other user’s FAXBOX directory.
If the user has the correct options turned on, that user will receive Email, or
perhaps the user’s computer will “beep.”

To forward a fax to another, user, select the fax from the browser and press the
Forward button which is shown to the left. The Forward Fax window will
appear, as shown below Figure 4-5.

Figure 4-5 The Forward Fax Window

Type the Email address of the user you want to receive the fax. You may
choose several different methods of forwarding faxes:

TEDfax Forward The default method, described above.

Electronic Mail The fax will be sent in Email format to the other user.
Use this format for sending faxes to TEDfax users at
other companies.

Other Allows you to specify a shellscript to use to forward
the fax.

When you’re ready, press the Forward button to send the fax to the user you’ve
specified. To close the screen without forwarding the fax, press the Cancel
button.
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Navigating the Filesystem

As mentioned before, the list in the middle of the View screen is actually a file
browser. Received faxes are stored as files.

If you wish, you can navigate around your filesystem using the View Screen
similar to the way you can with the File Manager. The following features help
you navigate:

Up Moves back one directory in the filesystem hierarchy,
like typing “cd ..” in a UNIX shell. For example,
pressing Up when the Directory textfield reads
“/usr/myname/dirA” would move you to the
directory “/usr/myname”.

Home Moves to your home directory, like typing “cd ~”
from a UNIX shell.

Sort By Allows you to sort the list of files by alphabetical order,
or by the date the file was created.

Using Faxes with Other Applications

The Applications menu allows you to install links to other applications, so that
you can view, edit, or manipulate faxes using your favorite software.

Each entry in the Applications menu is a shellscript that’s been given a name of
your choice. When you select the entry from the menu, TEDfax calls the script
it represents, including the filename of the selected fax.
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You can customize the contents of the Applications menu by selecting
Customize Applications from the File menu. The Customizer window is shown
here in Figure 4-6.

Figure 4-6 The Customizer Window

To add an entry, type the name you wish to call the entry, the shellscript it’s
supposed to represent, and press Add. To remove an entry, click the entry in
the list, and press Remove. To change the name or script of an entry, click on
the entry, make your changes to the fields below, and press Change. To close
the screen, press OK.
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Customizing the QuickKeys Menu

The QuickKeys menu is just a list of important directories. Use it to quickly
move to directories you’re interested in. You can add directories by selecting
Customize QuickKeys in the File menu. The QuickKeys Customizer Screen is
shown below in Figure 4-7.

Figure 4-7 QuickKeys Customizer

To add a directory entry, type the name you wish to call the directory, the path
of the directory, and press Add. To remove a directory entry, click the entry in
the list, and press Remove. To change the name or path of a directory entry,
click on the entry, make your changes to the fields below, and press Change. To
close the screen, press OK.
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Using TEDfax Phonebooks 5

The Books Screen allows you to access TEDfax’s Phonebooks. Often TEDfax
users send faxes to the same people, or group of people. To save you time,
TEDfax has a built in Phonebook that will remember these frequent fax
recipients. After you add these people to your Phonebook, you don’t have to
type these fax numbers again; TEDfax will automatically do it for you. You can
also create Phonebook entries that contain lists of people. This feature allows
you to send a fax to many people, just by selecting a single Phonebook name.

To look at the contents of your Phonebooks, double click on the FaxBook icon
in the Application Manager.

Adding People to a Phonebook 56

Adding Lists to a Phonebook 56

Sending Faxes to People and Lists 58
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1. Locate the FaxBook icon in the Application Manager. It resembles the button
shown below in Figure 5-1.

Figure 5-1 The FaxBook Icon

2. Open the FaxBook icon, by moving the mouse cursor over it and double-
clicking the left mouse button.
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The Books Screen, as shown below in Figure 5-2, will be displayed. As you may
recall, you added yourself to the phonebook tutorial within Chapter 3 (when
you were learning how to send faxes). The Phonebook list will only contain
yourself in its list.

Figure 5-2 The Books Screen

Note – Your screen will likely be different than the one shown and the
following examples will be different too, but all the pieces will be present. The
information presented, however, applies to all TEDfax Phonebooks.

The left-most part of the screen is a list of everyone in the phonebook; we’ll call
that the Phonebook List. The name of the phonebook being displayed is at the
top of the list. You may have as many phonebooks as you want, but there will
usually be two when you first install TEDfax: Your Private Phonebook (one to
which you have read and write access) and the Server Phonebook (that
everyone in your company can read). To choose which one to display, press
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and hold down on the name of the phonebook. A menu of all installed
phonebooks will appear. Release the mouse button over the name of the
phonebook you want to see.

The right-most part of the screen displays the stored information about the
person who is currently selected in your Phonebook List. To view the
information about someone else, just click on their names in the Phonebook
List.

Adding People to a Phonebook

You added yourself to the phonebook in the tutorial within Chapter 3. So, most
likely, the Phonebook list will only contain yourself in its list. If you’ve just
installed TEDfax, there probably isn’t anyone in the list, so let’s add someone.
First decide to which phonebook you want to add the person, and select that
phonebook (as explained above.) Now, click on the Name field and type the
name of the person you want to add. Hit the <Enter> key to get to the next
field, or just click on the field you want, and enter the appropriate information.
You can add a note or two about the person, if you wish. TEDfax doesn’t use
the information in the Notes field, so you can do whatever you’d like in that
field.

When you’re done, Press Save As New at the bottom of the screen. The
person’s name will now appear in the Phonebook List, and will appear every
time you open the Books Screen and select this Phonebook.

If you want to change something about a person (or at least, about your
information regarding them) click on the person’s name in the Phonebook List,
change the fields you want to change, and press Save Changes.

Keep in mind the difference between these two buttons: Save As New saves the
information as an entirely new person. Save Changes just modifies the
information about an existing person.

If you decide you don’t want a person in your Phonebook, just click on the
person’s name in the Phonebook List and select Remove Person from the Edit
menu. The person will be deleted from the phonebook.

Adding Lists to a Phonebook

TEDfax allows you to create lists of people. For example, you may create a list
of all your branch offices, so that you can send a fax to all of them at once.
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To view the lists in a phonebook, press the Lists toggle, located just below the
Phonebook List.

The Phonebook List will now display all the lists contained in the selected
phonebook. The right side of the screen now shows information about the list
currently selected in the Phonebook List.

Note – Your screen will likely be different than the one shown on the next
page, but all the pieces will be present. The information presented, however,
applies to all TEDfax Phonebooks

The Lists Toggle is shown below in Figure 5-3.

Figure 5-3 The Books Screen Lists Toggle
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On the left is the Name of the current list, and a list showing everyone who is
in the current list. On the right is a list of all the people in the current
phonebook, called the List Contents. To add a person to a list, click on the
person’s name in the right-most list, and press the Arrow button to move that
person into the List Contents.

You can add both people and other lists to your list, but you can only add
things from the currently selected phonebook, not from other phonebooks.

The Save As New button, the Save Changes button, and all the other buttons
work exactly as previously described.

Sending Faxes to People and Lists

To send a fax to a person or list of people, just select the person’s name from
the Phonebook List and press Send To. The Send Screen will appear (if it isn’t
up already) and the person or list will be added to the To region.

You can add as many people as you want this manner. The To region of the
Send Screen becomes a list, and all the people/lists you’ve added will appear
in the list. When you press Send Fax, the fax will be sent to all of them.

You can more easily add groups of people by clicking the Destinations button
in the Send Screen.

A miniature version of a Phonebook screen will appear, with an Arrow button
to allow you to add people and lists to your list of Destinations. To return to
your original view of the Send Screen, press the Overview button.

To close the Books Screen, select the Done button from the File menu.
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Using TEDfax Queues 6

The Queues screen displays the current status of TEDfax’s outbound fax
queues. It can be used to monitor the status of the queues and the fax modems
servicing those queues.

To look at the contents of your fax queue, double click on the Queues icon in
the TEDfax folder in the Application Manager.

1. Locate the FaxQueue icon in the TEDfax folder in the Application Manager.
It resembles the icon shown below in Figure 6-1.

Figure 6-1 The FaxQueue Icon

Queue Screen Menu Bar 61

Queue Screen Action Buttons 61
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2. Open the FaxQueue icon, by moving the mouse cursor over it and double-
clicking the left mouse button.

The Queues Screen, as shown here, will be displayed. Depending on the
amount of fax activity, the TEDfax Queue Screen may be filled with items, or it
may be empty. The Queues Screen is shown below in Figure 6-2.

Figure 6-2 The Queues Screen

Note – Your screen will likely be different than the one shown and the
following examples will be different too, but all the pieces will be present. The
information presented, however, applies to all TEDfax Queues.

Using this screen, users and administrators may “hold” items in a queue,
delaying their transmission, or may change the order of items in a queue.
Functionality similar to that of the UNIX commands lpq, lprm and lpc is
provided.

The Queues screen consists of a menu bar, a Modem Info region, and a
browser. Combined, these items show the complete, exact, and current contents
of the queue. Each modem has its own queue. As each fax is transmitted, it will
disappear from the queue.
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Popup menus activated with the right mouse button allow you to reorder the
queue. The options are “move to top”, “move up one”, “move down one”, and
“move to bottom”.

Queue Screen Menu Bar

The Queues screen menu bar contains the following functions:

File Contains the View Log... and Done menu items.

View Log... This file keeps a record of each successful transmission
which you queued. This log is only kept if you request
it through the View/Options panel.

Done Closes the screen.

Help... Displays help information.

Queue Screen Action Buttons

To perform an operation on a fax, select it using the mouse button (as you
would in the File Manager), and press the button for the desired action located
at the bottom of the screen. You will sometimes find it helpful to “Hold” the
fax to temporarily prevent its transmission and removal from the queue. You
must own the fax to alter its state in the queue. Only the TEDfax administrator
and those users listed in the file /var/dt/fax/data/fax_admin may alter
other people’s faxes and move faxes around in the queue. The Queues Screen
has the following action buttons:

Hold Freezes the selected fax in the queue, temporarily
preventing its transmission. Only the owner of the fax
or an authorized TEDfax administrator may hold a fax.

Requeue Unfreezes the selected fax, if it was being held,
allowing its transmission. Only the owner of the fax or
an authorized TEDfax administrator may requeue a
fax. This can also be used to re-try the sending of a fax
before the retry time has elapsed.

Remove Removes the fax from the queue, cancelling its
transmission. Only the owner of the fax or the
administrator may remove a fax from the queue.
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View... Views the selected fax. A coverpage will be rendered
when View is requested in order to allow you to view
the full fax. Only the owner or an authorized TEDfax
administrator may view a fax.

Print... Prints the selected fax. Only the owner or an
authorized TEDfax administrator may print a fax.

History/ Modify... Opens the Queue Edit screen, allowing the user to edit
transmission options, like the destination fax number
of the fax. Only the owner or an authorized TEDfax
administrator may modify a fax. You must click on
“save” after you make any changes to the transmission
options.

The Queues Screen Modem Info Region

The Modem Info region displays the status of each modem driver. To change
the modem shown, pull down the menu button in this region with the right
mouse button and release the button on the name of the desired modem. The
status and queue list of the newly selected modem will then be displayed.

The status of the modem is updated frequently by the modem driver and the
faxserver process. If the TEDfax_modem process is functioning properly, the
status field will “flicker” every thirty seconds or so.

The Modem Info... button opens the Modem Info screen, which displays the
currently active options and information for the modem displayed.

The Modem Info... popup allows the fax administrator to hangup, restart or
terminate the TEDfax modem process for a given modem. It also allows the
administrator to redefine some of the phone number strings for the faxmodem
as well as to determine if the fax modem is allowed to transmit or receive
faxes.

Clicking on “Restart” will attempt to kill off the current modem daemon
process running for this fax modem by sending it a “kill -TERM” signal.   It
will then attempt to restart a new TEDfax_faxmodem process.   Both these
actions are done by the TEDfax_serverd process.
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Any changes made in the modem info panel (such as phone number changes
and the like) must be followed by a “Save” operation.   Also, once a change has
been saved you must “Restart” the modem process for it to recognize the
changes you have made.   Thus if you wish to disable reception of faxes for a
given fax modem, you would:

• Uncheck Fax Reception,

• Save new settings,

• Restart the fax modem in question.

The Queues Screen List

The browser in the center of the Queues screen displays the faxes waiting for
transmission by the selected modem. When a fax is to be sent to more than one
destination, it will appear as more than one entry in the queue. Thus if you
send a single fax to ten people, you will see ten entries appearing in the fax
queue, one for each recipient.

Select an individual fax by clicking on it with the left mouse button. Once
you’ve selected a fax, you may perform any of the Queue Screen actions, via the
action buttons.
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Drag and Drop 7

This chapter outlines the drag and drop functionality within TEDfax.

The instructions in this chapter assume you are familiar with basic desktop
skills, drag and drop functionality, and keyboard navigation. For more
information, see the Chapter 1, “Basic Skills” and the Appendix A, “Keyboard
Shortcuts for the Desktop” of the TriTeal Enterprise Desktop User’s Guide.

Drag & Drop between TEDfax and the Desktop

TEDfax has two active drop zones within the Application Manager. You may
either drop a fax icon onto the EditFax icon to open up the fax for editing or
you can drop any object onto the SendFax icon to include it as an attachment to
a new fax.
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Only faxes can be dropped onto the Edit icon. The Edit screen will not open if
anything other than a fax is dropped onto this location. The EditFax icon is
shown below in Figure 7-1.

Figure 7-1 The EditFax Icon

Any object may be dropped onto the SendFax icon. When something is
dropped onto the SendFax icon, the Send screen will open with the item you
just dropped there in the attachments area. The SendFax icon is shown below
in Figure 7-2.

Figure 7-2 The SendFax Icon

Note – If you drop a fax onto the SendFax icon it will become an attachment in
a new fax.

▼ To Drag an item from Another Application to TEDfax

From Mailer or File Manager, and possibly other applications, you can drag a
fax icon to TEDfax for several different purposes.
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From Mailer

1. Select the object (attachment or mail that has been saved as text) that you
wish to include as an attachment in your fax.

2. Drag the object to TEDfax and drop it on the Send icon.

The pointer changes to an icon representing the moving file.

The Send screen will appear with the object included as an attachment in a
new fax.

Note – You cannot drag mail directly to TEDfax. You must first save the mail
message as text and then drag it from the location you saved it.

From File Manager

If you have a file containing a fax or object you wish to include as an
attachment:

1. In an open File Manager window, navigate to a folder containing the fax
you wish to edit or object you want to include as an attachment.

2. Drag the fax or other object to either the SendFax icon (to include it as an
attachment) or the EditFax icon (faxes only) and drop it.

▼ To Drag an item from TEDfax to Another Application

From TEDfax, you can drag an fax icon to Mailer to mail it to someone as an
attachment or to File Manager to save it in your file system or to Print Manager
to print a hardcopy of the fax.

To Mailer

1. Drag the fax icon from the Queues screen and drop it on Mailer’s
attachment list.

2. Compose and address your mail message and send it.

Note – In order read the attached fax, the person receiving the mail message
must will need an application that is capable of reading TIFF files (XV or
TEDfax will read TIFF files).
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To File Manager

1. In an open File Manager window, navigate to a folder where you want to
save the fax in a file.

2. With both the File Manager window and TEDfax on your screen, drag the
Drag fax icon from the Queues screen and drop it on the File Manager
window.

The fax is saved in a file in the folder where you dropped it.
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General Theory & Daemons

TEDfax uses a client/server model. TEDfax users run client applications to
build and view faxes; these client applications connect to a server process to
actually queue, transmit, and receive faxes.

Three background daemon processes are used by TEDfax:

TEDfax_serverd The most important daemon which handles all queue
and other control requests by users.

TEDfax_faxmaild Handles fax forwarding and sends user notifications.

TEDfax_modem Handles each modem. One TEDfax_modem process is
present for each installed modem, and is responsible
for communications between TEDfax and that modem.

Most TEDfax functions operate through shell scripts; this is an intentional
feature designed to make TEDfax as customizable as possible.

How TEDfax Restarts

When a machine serving as an TEDfax server is rebooted, the scripts
/usr/dt/fax/sbin/start_faxserverd,
/usr/dt/fax/sbin/start_faxmaild, and
/var/dt/fax/autoroute/bin/icr_server.sun (Solaris 1.x only) are
restarted from several lines added to the host dependent boot scripts
(/etc/rc.local, /etc/rc, or a file in /etc/rc2.d).

The first two scripts start TEDfax’s daemon processes. The third is required
when ICR autorouting is enabled. The TEDfax_serverd process, started from
running /usr/dt/fax/sbin/start_faxserverd, also forks an
TEDfax_modem process for each modem defined.

How TEDfax Sends Faxes

When an TEDfax user requests to send a fax, usually by pressing the Send Fax
button in the Send Screen, TEDfax attempts to “render” the body of the fax
using the shell script render. The resulting fax image is then transferred to the
faxserver for placement in an outbound queue.
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The “render” script is passed the file type, returned by the UNIX file
command, of each attached file. It uses the file type to execute the necessary
conversion utility to convert the file into a fax ready TIFF format.

The coverpage of the fax, if any, is not rendered until a modem is ready to
transmit the fax. This ensures the time-stamp of the coverpage will be accurate.

A queued fax is composed of a small configuration file, and a directory
containing the rendered image. The information required to render the
appropriate coverpage is “split” between this file and the rendered image
directory. This design allows TEDfax to minimize the disk space required to
send a fax image to multiple recipients. Only one copy of the “body” of the fax
is kept, saving a large amount of disk space.

The TEDfax_serverd Daemon

The TEDfax_serverd daemon is the heart of TEDfax. It is responsible for fax
modem feedback, and queuing of faxes into the outbound spool directories. It
also forks an TEDfax_modem process for each installed fax modem defined in
the file /var/dt/fax/data/faxdevices. The daemon is started using the
shell script: /usr/dt/fax/sbin/start_faxserverd.

For proper operation, the TEDfax_serverd process must:

• Run as root. The software uses the current UID to find the file .faxrc in the
home directory of the current user. This file (usually /.faxrc) defines
critical data and directories used by the software. Failure to find this file and
the information stored within it will prevent TEDfax from functioning
properly.

• Have write permission to /var/dt/fax/data,
/usr/spool/TEDfax/Any, /usr/spool/TEDfax/inbound, and any
other spool directories used.

The TEDfax_faxmaild Daemon

The TEDfax_faxmaild daemon handles the forwarding of faxes and user
notifications, including the updating of TEDfax’s log files. The daemon is
started using the shell script:

/usr/dt/fax/sbin/start_faxmaild
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This is usually started by the system boot scripts upon a system reboot. The
daemon is started automatically if a user runs TEDfax when the daemon is not
already running on the host. Technically, it should be started from the boot
script, such as /etc/rc or /etc/rc.local on any client machine.

Note – For proper operation, the TEDfax_faxmaild process must run as root.

The daemon is used to “forward” faxes into the defined faxbox of a user. In
order to write to the named directory, the daemon must be able to “become”
that user.

If the daemon is not running, TEDfax will be unable to forward faxes, update
the log files, or “beep” at the user; other TEDfax features will continue
unhindered.

When forwarding a fax to a user, the process will setuid to that user to avoid
security problems.

The TEDfax_modem Daemon

TEDfax modem daemons handle communication between TEDfax and each
installed modem. The TEDfax_serverd process will fork one TEDfax_modem
process for each modem.

The list of installed modems is defined in /var/dt/fax/data/faxdevices.

Note – /var/dt/fax/data/faxdevices is an internal TEDfax system file and
is <tab> sensitive. Do not edit this file by hand. To add modems or change modem
settings, login as root or su to root, and use the FaxAdmin tool.

The TEDfax_modem process opens the serial line associated with the fax
modem, sets up the modem to send and receive faxes, if those options are
enabled, and waits in a select() loop for incoming fax calls.

About every thirty seconds, the select() will time-out, and the process will
check its defined fax queue for transmission requests. If one exists, the process
will attempt to transmit it.
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The .faxrc File

When each new user starts TEDfax, the file “.faxrc” and the directory
“faxbox” are created in that user’s home directory, if they do not already exist.
The “.faxrc” file is created by running the shell script new_faxrc. This will
run automatically the first time a user runs “fax.”

The faxbox directory is used to store faxes received by the user.

The .faxrc file is used to keep each user’s defaults and options. The file is
updated each time the user selects “Save As Default” from an TEDfax screen,
or at other times when user defaults change.

Note – The .faxrc file must be writable by the user for TEDfax to function.

The .faxrc file is composed of lines of the form key<tab>value<return>
where the “value” field may in fact hold several tab-separated fields. The
<tab> characters are mandatory for proper key and value recognition. Lines
with unrecognized keys will be ignored.

A full list of values and their meanings is in their file:
/usr/dt/fax/man/man1/new_faxrc.1

Note – Editing of the .faxrc file by users is discouraged. Every option that
might require modification can be modified from within TEDfax. Editing the
file while TEDfax is running could have unintended consequences.

Administrators may modify the new_faxrc script to change the default values
TEDfax places in the .faxrc files of new users.

Ownership and Permissions

The directory /usr/dt/fax should be owned by the user “bin” and be
writable by “bin”. It should have the permissions “drwxr-xr-x”.

All files in /usr/dt/fax should be owned by “bin” except:

• /usr/dt/fax/sbin/TEDfax_faxmaild should be owned by root.

• /usr/dt/fax/filters/fax_filter should be owned by root.
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The directories in /usr/dt/fax should also have the permissions “drwxr-
xr-x”.

/usr/spool/TEDfax/lock should have the permissions “drwxrwxrwx”.

The .faxrc file present in each TEDfax user’s home directory must be
writable by the user at all times.

Xt Resources

The TEDfax interface is Xt-based, and uses Xt style resources. The Xt resource
file should be placed in /etc/dt/app-defaults/C/Fax.

If the resource file is not found, the colors and fonts TEDfax uses may be
awkward, and some screens may appear “too small” to hold their contents.

Fax.ad Resources

The file /usr/dt/fax/Fax.ad contains the resources used to define the
colors, fonts, and the names of buttons you see in your pull-down menus.
Changes can be made to this file to change the name of the strings.

TEDfax’s Shell Scripts

Many of TEDfax’s features have been implemented through shell scripts. This
allows experienced UNIX users to easily customize TEDfax’s behavior. The
scripts are located in /usr/dt/fax/bin. The Shell Scripts are listed below.

Table 8-1

Shell Script Name Function

archdir Prints current host architecture.

render Converts documents of various types into fax
(TIFF) format.

TEDfax_forward Handles fax forwarding.

TEDfax_notify Handles user notifications.

TEDfax_sendmail Handles sending Email on the current system

TEDfax_print Handles the printing of faxes.
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The “render” Script

The “render” script controls rendering of different file types into fax format;
namely, TIFF.

The script accepts the following arguments:

render <file_type> <input_file> <macro> <output_file> <host>
<port>

The file type is determined by running /bin/file. The special case of “TIFF
file” is also recognized if TEDfax determines the file is already in TIFF format.
(“TIFF file” is not a normal /etc/magic entry.)

Case statements within “render” handle individual file types. You may add
format converters of your own; for example, if you have the program
“ptroff” and want TEDfax to properly format nroff, troff, or ptroff formats,
add the lines below to the script:

“[nt]roff, tbl, or eqn input text”)
ptroff -t $FILE | /usr/dt/fax/bin/ps2x -out $OUTPUT
exit 0
;;

The “TEDfax_forward” Script

The “TEDfax_forward” script handles the forwarding of faxes.

The script accepts the following arguments:

TEDfax_forward <forward_type> <to_address> <filename>

A case statement within the script is used to branch between the different
available forwarding mechanisms. The installed options are:

TEDfax_logfilter Handles the filtering of log files.

new_coverpage Creates a coverpage for new users.

new_faxrc Creates .faxrc files for new users.

faxq Allows users to list the contents of a modem’s
outbound fax queue or to delete faxes owned
by them from the UNIX command line. Similar
to lpq/lprm.

Table 8-1



76 TEDfax User’s Guide

8

“TEDfax” Runs TEDfax_forwardfax, which uses the
TEDfax_faxmaild daemon to forward the fax.

“email” Uses uuencode and /bin/mail to forward the fax.

Additional statements may be added to take advantage of the “Other” field in
the Forward screen. For example, to add a mechanism called “x25” which uses
a program called “x25-transfer” to forward files, add the lines below:

“x25”)
x25-transfer $ADDR $INPUT
exit 0
;;

The “TEDfax_notify” Script

The “TEDfax_notify” script handles user notifications requested by the
TEDfax_modem driver.

The script accepts the following arguments:

TEDfax_notify <notify_type> <to_address> <host> <port> <modem>

A case statement within the script is used to branch between the different
available options:

“success” Executed when a fax is successfully transmitted.

“retry” Executed when a fax transmission fails, but will be
retried.

“failure” Executed when a fax transmission fails, and will not be
retried.

“newfax” Executed when TEDfax receives a new fax.

“feedback” Executed when the TEDfax_modem process needs to
send feedback to the user.

“telebit-proms” Executed when older-version Telebit proms are
detected which are not compatible with TEDfax. Sends
Email to root.

“deadmodem” Executed if the TEDfax_modem process has been
unable to communicate with the modem for five
minutes or longer.
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The “TEDfax_print” Script

The “TEDfax_print” script handles the printing of faxes. The following
arguments and flags are recognized:

TEDfax_print <filename> <printername>
[ file | Postscript]
[ -copies ncopies ]
[ -from frompage ]
[ -to topage ]
[ -manual ]
[ -lowres ]
[ -width n_inches ]
[ -height n_inches ]

Note that the provided implementation of this script does not take advantage
of the “-manual”, “-lowres”, “-width” or “-height” flags. You may
modify this script to use these options if they make sense to your printer.

This script uses a slightly modified version of “fax2ps” to convert TIFF fax
files to compressed PostScript, with options added to allow the printing of
page ranges. One could also use “tifftops”, but much larger files are
generated.

The “TEDfax_logfilter” Script

The “TEDfax_logfilter” script is used to filter the onscreen display of log
files in the Log screen.

A case statement within the script is used to branch between the different
available filters. Additional filters may be added and installed into the Log
screen. For example, to add a filter called “newcase”:

Add the following lines to the TEDfax_logfilter script:

“newcase”)
awk -F<tab> ‘{printf “%5.5s %5.5s %8.8s %5.5s %20.20s \
%15.15s %15.15s\n”, $1, $2, $4, $5, %6, %7, \
$8, $9}’ \
$FILTER_INPUT >> $FILTER_OUTPUT
;;

Add the following line to your .faxrc file:

FAXFilterKey:<tab>newcase
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The “new_faxrc” Script

The “new_faxrc” script is used to create the .faxrc files of new TEDfax
users.

Administrators may modify the script to change the default values TEDfax
places in each user’s .faxrc file.

Remember the .faxrc files of existing TEDfax users are not modified by this
script.

Customizing Font and Size for Text Files

The TEDfax_pstext program converts ascii text to postscript as a first step to
rendering an ASCII file into a fax. This program is run from
/usr/dt/fax/bin/render in the default case ( “*)” ) at the end of the file.

TEDfax_pstext can take the following arguments:

-width <WIDTH> Define WIDTH characters per line. This is used to
determine where to ‘wrap’ a long line around. The
default is 80.

-length <LENGTH> Define the length of a page. This is used to determine
where to do a page break. The default is 60 lines.

-font <FONTNAME> The font name to use. The default is:
CourierBold. Other font names may be picked from the
file:
/usr/dt/fax/gsdir/Fontmap.

-size <FONTSIZE> The size of font to use, and the size + 0.4 to use as a
‘vertical space per line’. The default is point size 12.

In addition to these ‘command line’ parameters each user may select the font
name and font size to use via an entry in their .faxrc file. Among the entries
are:

FAXTextFont: Courier-Bold

FAXTextSize: 12

FAXTextWidth: 80

FAXTextLength: 60
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These parameters, if present in a users .faxrc file, will override the defaults
when the user runs “fax” or “sendfax.”

Faxing from the Command Line

The “sendfax” program allows users, and other applications, to send faxes
without using the graphical interface. The table below lists the command line
options which may be passed to sendfax.

Table 8-2 Command Line Options

Argument Description

-n “name” Destination Name.

-o “company” Destination Company Name.

-p “fax#” Destination Fax Number.

-v “phone#” Destination Voice Number.

-f <filename> Attach File. Currently only ASCII Text, PostScript,
and TIFF files are supported from the command line
interface.

-m <modem> Use Modem - default is ‘modem1’.

-b Bannerless - Suppress generation of a coverpage.

-l “listname” Include recipients of the named list.

-c <path> Specifies full path (on local host) to a PostScript tem-
plate file to be used as the coverpage for this fax.

-fn <name> Use <name> for the From Name field.

-fo <organization> Use <organization> for the From Organization field
on the coverpage.

-fv <voice #> Use <voice #> for the voice number field of the cover-
page.

-fp <phone #> Use <phone #> for the phone number field of the cov-
erpage.

-lf <logfile> Use <logfile> as the full path for the logfile to use
when logging successful fax transmissions.
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-ns <user@host> Send Email to <user@host> when a fax transmits suc-
cessfully.

-nr <user@host> Send Email to <user@host> when a fax has to retry
(due to BUSY, NO CARRIER, etc).

-nf <user@host> Send Email to <user@host> when a fax has retried the
maximum number of times and has thus failed.

-es <path> Specify <path> (on faxserver) of a program to execute
when a fax successfully transmits. <path> will be run
with argv[1] set to the full path of the faxsf file for the
fax.

-er <path> Specify <path> (on faxserver) of a program to run
when a fax retries due to BUSY, etc.

-ef <path> Specify <path> (on faxserver) of a program to run
when a fax fails.

-rt <minutes> Specify number of minutes to wait before fax should
be retried.

-mr <count> Specify number of times a fax may retry before fail-
ing.

-s <subject> Specify Subject field to appear on coverpage.

-debug Tells “sendfax” to print step-by-step and temporary
file info of fax request.

-ignore_tilde Tells sendfax to ignore processing “~” requests from
standard input. Software which redirects output into
sendfax should use this flag.

-ignore_route Tells sendfax not to attempt to decode any possible
router information from text or PostScript docu-
ments. This speeds things up.

-is_binary Tells sendfax that the standard input coming into
TEDfax is a binary file. Use this when pushing raster
files and the like into sendfax.

-job J<string> Used to pass in “job” field from LPR daemon. The
<string> may contain a “name, org, phone”.

Table 8-2 Command Line Options

Argument Description
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Faxing from the Command Line Examples

Send “myfile” to Bob Smith through modem1:

> sendfax -n “Bob Smith” -o “TriTeal” -p “555-5555” \
-v “555-1234” -f ~mydir/myfile -m modem1

Send “myfile” without a coverpage to everyone in the list named “TriTeal
Corporation Offices”:

> sendfax -b -f ~mydir/myfile -l “TriTeal Corporation Offices”

Send the coverpage file “coverfile.ps” to everyone in the list named
“Customers” WITHOUT a fax body. This is good for a one page flyer:

> sendfax -empty -c ~mydir/coverpage.ps -l “Customers”

Remember to use quotes around arguments containing spaces. If no arguments
are present, the user will be prompted for the file to be faxed and the
destination’s name, company, phone number, and fax number.

-empty No data file (used for sending just a coverpage).

-qt <HH:MM> Set Queue time for this fax to HH:MM. This lets users
queue faxes to be transmitted after a given HH:MM.

-email_filter Treat As Email.

-hf Hold on failure. Will cause fax to be marked as “held”
instead of deleting it from transmit queue if “max.
retries” occurs.

-cm <-> Continue on retry. If set and the fax fails to get
through will re-send the coverpage and skip the
pages that have been transmitted correctly.

Table 8-2 Command Line Options

Argument Description
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Faxing from Other Applications

Documents may be faxed from within other applications by simply “printing”
them to the printer “fax” and including the option “-J” in the string passed to
lpr or including the appropriate routing information (embedded routing
commands) in the document. These are both described in detail in the section
titled Faxing through UNIX lpr.

Alternatively, many applications may be customized so that printing to the
printer “fax” will open the TEDfax Send screen with the document to be faxed
already attached. The user may then enter the destination(s) and other
information for the fax, and click on “Send Fax”.

To accomplish this integration, the print script of the calling application must
be modified to recognize the “fax” option. The scripts for FrameMaker,
Interleaf, and Island products have been included in the directory
/usr/dt/fax/utils, along with installation instructions for these scripts.

For FrameMaker, the following lines should be added to the case statement of
the $(FMHOME)/.fminit2.0/FMlpr script:

case “$1” in
[xX][pP][rR][fF][aA][xX])
TEDfax_HOME = <the path to ~fax>
$TEDfax_HOME/bin/fax -qf $2
/bin/rm -rf $2
;;

Finally, for non-GUI applications, you can add faxing as an output option
using “sendfax” by simply building a system() or popen() request to send
fax. In example:

char command[BUFSIZE];
FILE *fp;
sprintf (command, “/usr/dt/fax/bin/sendfax
-f %s -n\”%s\” -p\”%s\””, file, name, faxn);
pclose (fp);

Faxing through UNIX lpr or lp

An alternate method of sending a fax is to “print” the fax to the printer “fax”.
A “-J” option provides destination information.

For example, to send a fax to “Bob Smith” of the company “Bob Co” with a fax
number of 818 555-5555, you could type:
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% lpr -Pfax -J“Bob Smith, Bob Co, 818 555-5555” /tmp/doc

or

% lpr -Pfax -J“Bob Smith, Bob Co, 818 555-5555”
Hi Bob. Here’s the fax you asked for...
^D

Note that there is no space between -J and the following quote. The same may
be done using the SYSV lp command. Refer to the section titled, Faxing using
UNIX lp.

Alternatively, embedded routing commands may be placed on the first page of the
document, eliminating the need for the “-J” option. This works even if the
document is a PostScript file. Routing commands are (case-insensitive) macro-
substitutions embedded within the fax that define routing information for the
fax. The same fax could be sent using routing commands as follows:

% lpr -Pfax
faxto_name: Bob Smith
faxto_org: Bob Co
faxto_phone: 818 555-5555
faxbegin:
^L (CONTROL L)
Hi Bob. Here’s the fax you asked for...
^D

Note – For standard text to PostScript conversion, the ^L is converted to a page
break. If you’re using a text editor, you should replace the ^L with whatever is
necessary to skip to the next page.

About the UNIX lpr Link

The ability for users to send faxes through “lpr” is accomplished by installing
a “dummy printer” which acts as an input filter into TEDfax.

The default installation of the software installs a dummy printer named “fax”
in the fax server’s /etc/printcap file and creates the spool directory
/var/spool/fax.

The lines inserted into the server’s /etc/printcap file are:
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fax|fax|TEDfax Input Filter:\
:lp=/var/spool/fax/null:sd=/var/spool/fax:\
:if=/usr/dt/fax/filters/lpd_filter.sh:\
:lf=/var/spool/fax/lw-log:mx#0:sb:

The directory /var/spool/fax contains the following files:

drwxr-sr-x 2 root ? Jul 10 14:33 .
-rw-r--r-- 1 root 0 Jul 10 14:33 lw-log
-rw-r----x 1 root 4 Jul 12 16:37 .seq
-rw-r--r-- 1 root ? Jul 12 16:37 null
-rw-r--r-- 1 root ? Jul 12 16:37 lock
-rw-r--r-- 1 root ? Jul 12 16:37 status

Recognition of Router Strings

When a fax containing embedded router strings is passed through lpr to
TEDfax, it is TEDfax's job to recognize that the documents first page contains
these router strings. Upon recognition, TEDfax must extract the information
specified and then remember to strip off (or throw out) this first page after
rendering the document so that it is not sent with the fax as a part of the body
being faxed.

The “cookie” which tells TEDfax that a document’s first page contains
embedded router commands is the presence of the keyword “FAXBegin:” on
the first page. If this word is present, then the first page will be “tossed” after
any additional router commands and data have been extracted.   If this word is
not present then the document will be assumed to have no embedded router
information.

If the document is straight ASCII text, this becomes fairly simple. TEDfax can
just scan for the keyword “FAXBegin:” and do the right thing.

However, most documents containing embedded router commands actually
come from fancy WYSIWYG editors that have produced PostScript output.
TEDfax thus has an additional task of trying to decrypt from the PostScript the
first page as text before it can begin to determine if the first page contains the
keyword “FAXBegin:” with other embedded router commands and datum.

TEDfax uses the shell script “/usr/dt/fax/gsdir/pstotext.sh” along
with one of two possible heuristics to attempt to convert PostScript to text.   If
the heuristic fails to extract keywords properly, as can be the case, then TEDfax
won't be able to identify the embedded router commands present on the first
page and will ignore them. This often results in a failure to queue the fax.
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Most applications which generate PostScript do it consistently. Thus once a
“good” heuristic is found for a sample PostScript document generated with a
specific application, it is likely that all documents generated by that application
will be properly processed using the same heuristic.   See the Appendix A,
Testing and Adding PostScript Heuristics for Extracting Embedded Router
Commands for details on testing and updating pstotext.sh to work with
specific applications PostScript files.

Faxing using UNIX lp

SYSV machines, such Solaris 2.3 and HPUX, also feature a print mechanism
through an 'fax printer model' script.   Instead of an entry in /etc/printcap
these hosts have a small shell script which defines a printer “model”. This
script is used to pass printer requests which come in through lp directly to
TEDfax.

The shell script is usually stored in /etc/lp/model or
/usr/spool/lp/model under the name 'fax'.   For details on the script,
refer to /usr/dt/fax/filters/lp_filter, /usr/dt/fax/filters,
lp_set.sh, and /usr/dt/fax/filters/lp_model.template. For
example, see below:

lp -n fax -t “Bob Smith, BobCo, 5551212” /etc/motd

Faxing using UNIX Mail

Users may also send a fax by sending Email to the user “fax”. The destination
of the fax must be specified in the Subject line, or be embedded as routing
information at the top of the message being sent. Because of this, the “Subject”
line will NOT be used as the “Subject” field in the fax cover page.

For example, to send a fax to “Bob Smith” of the company “Bob Co” with a fax
number of 818 555-5555, a user might type:

% Mail fax
Subject: Bob Smith, BobCo, 818 555-5555
Hi Bob. Here’s the fax you asked for...
^D

This same fax could be sent using embedded routing commands as follows:
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% Mail fax
Subject:
faxto_name: Bob Smith
faxto_org: Bob Co
faxto_phone: 818 555-5555
faxbegin:
^L (CONTROL L)
Hi Bob. Here’s the fax you asked for...
^D

Note – For standard text to PostScript conversion, the ^L is converted to a page
break. If you’re using a text editor, you should replace the ^L with whatever is
necessary to skip to the next page.

Failure to include enough routing information for at least one recipient will
result in TEDfax sending Email back to the user who attempted to send the fax.

The limitation of faxing via command line Email is that there is no provision
for attaching multiple documents. The only exception to this currently
supported by TEDfax, is that mail attachments of postscript and text files done
using Sun’s “mailtool” will be properly interpreted by TEDfax. Thus,
mailtool users may compose Email to “fax”, specifying the destination in the
subject field or in the main body of the Email using router strings.

About the UNIX Mail Link

The ability for users to send faxes by Email is accomplished via a “dummy
user” which acts as an input filter into TEDfax.

The default installation of the software installs a dummy alias named “fax” in
the fax server’s /etc/aliases file and runs the program “newaliases” to
make this entry visible to the system.

The line which is placed in /etc/aliases is:

fax:”|/usr/dt/fax/filters/mail_filter.sh”

Remember that if you edit /etc/aliases, you must run “newaliases”
afterwards.
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Faxing from Non-UNIX Computers

Many non-UNIX based computers connected to your network can also fax
documents using TEDfax if those computers are able to print to UNIX printers.
Simply print the fax to the printer named “fax”.

If the computer’s print managing features do not allow you to append the
“-J” flag to the print command (most do not), you must place routing
information on the first page of your document so that TEDfax can determine
who the fax should be sent to. Failure to do so will result in the fax failing to
queue for transmission. In this event, TEDfax will attempt to send Email to the
person who tried to queue the fax; note that this may be a problem if it was
queued from a non-UNIX computer which cannot receive Email.

Using Embedded Routing Commands

Routing commands are macro substitutions embedded within the first page of
a document to be faxed that define routing information for that fax. They are of
the format:

key: value

If a set of these strings, followed by the string “FAXBegin:”, appears on the
first page of a document, then that information will be used to route the fax.
The routing information, up to and including the string “FAXBegin:”, will
then be stripped from the document.

As an example of automatic routing, suppose the ASCII file (or PostScript file)
“file_to_bob” contained, in part:

FAXto_name: Bob Smith
FAXto_voice: 818 555-1234
FAXto_phone: 818 555-5555
FAXbegin:
^L
Hello, Bob. I just wanted to send you this...

The commands FAXto_name, FAXto_voice, FAXto_phone, and FAXbegin
would be recognized as embedded routing commands. The actual document to
be faxed would begin after the string “FAXbegin:”.
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Note – Be sure that your print generator is not configured to do page reversals,
as TEDfax will only search for router information on the first page of a
document!

Recognized Routing Commands

The following keys are recognized when searching for embedded routing
commands. Keys are case-insensitive. Examples of values used are also given.
Refer to the table below

Table 8-3 Recognized Routing Commands

Routing Command Example Description

FAXAuthor Bob Smith String to appear in “From Name” field.

FAXto_name John Doe String to appear in “To Name” field.

FAXto_org JohnCo String to appear in “To Company”
field.

FAXto_voice 818 555 1212 String to appear in “To Voice Number”
field.

FAXto_phone 818 555 1212 String to appear in “To Fax Number”
field.

FAXfrom_name: Rob Samson String to appear in “From Name” field.

FAXfrom_org: SamSon Inc. String to appear in “From Company”
field.

FAXfrom_voice: 619 555 1212 String to appear in “From Voice” field.

FAXfrom_phone: 619 555 1213 String to appear in “From Fax” field.

FAXlist “Sample List” List Name to use to generate destina-
tion list.

FAXOrigName /etc/motd Original name of file (for logging pur-
poses.)

FAXModem modem1 Name of modem to use.

FAXtmp /tmp Path of temporary directory to use.
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FAXServerPasswd Password (if any) for faxserver.

FAXNotifySuccess root Send email to this person if fax trans-
mits successfully.

FAXNotifyFailure root Send email to this person if fax fails to
transmit.

FAXNotifyRetry root Send email to this person if fax fails
but will retry.

FAXUserLog hostname Hostname to contact for “successful
transmit” log update.

FAXRetryCount 3 Maximum retry count.

FAXRetryDelay: 10 Retry delay time in minutes.

FAXBannerServer
FAXCoverServer

(no value) If defined, use the server banner page
mechanism

FAXBannerNone
FAXCoverNone

(no value) If defined, no cover page will be ren-
dered.

FAXCover <path> Full path to coverpage postscript file to
use.

FAXSubject <string> Specify subject string to use.

FAXHoldOnFailure <-> If the fax fails to transmit after the
maximum retry count specified mark
it as Held in the output queue instead
of deleting it.

FAXContinueOnRetry <-> If a fax fails to transmit and retries re-
send the coverpage and then skip
pages which have already transmitted
correctly during the last transmit
attempt.

FAXExecuteSuccess <path> Execute the command <path> on the
server host when the fax transmits suc-
cessfully.

Table 8-3 Recognized Routing Commands

Routing Command Example Description
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ICR Autorouting

When a fax is received, TEDfax stores the fax in the INBOUND spool directory
(/usr/spool/TEDfax/inbound). If ICR autorouting is enabled, an attempt
will be made to autoroute the fax to the correct TEDfax user, using the
Xerox/ScanWorX ICR engine to search the fax’s coverpage for the names of the
probable destinations.

Autorouting is enabled or disabled by checking or un-checking the ICR
Autorouting checkbox in the View Options screen. This must be done while
running TEDfax as the TEDfax administrator. Autorouting is enabled by
default.

FAXExecuteRetry <path> Execute the command <path> on the
server host if fax is to be retried due to
a busy signal, etc.

FAXExecuteFailure <path> Execute the command <path> on the
server host if the fax fails to transmit.

FAXContinueOnRetry: - If defined, retry attempts will re-send
the coverpage and then skip pages
which have already transmitted cor-
rectly, only transmitting the remainder
of the document.

FAXCoverLine: <string> Add another line of text to appear on
the cover page (up to 15 lines). This is
an alternative to
FAXMemoBegin/FAXMemoEnd.

FAXMemoBegin: - Start of up to fifteen (15) lines of text to
appear on the cover page.

FAXMemoEnd: - Signals end of lines of text to appear on
coverpage.

FAXBegin: - Keyword which tells TEDfax that there
are router strings.

Table 8-3 Recognized Routing Commands

Routing Command Example Description
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The file /var/dt/fax/autoroute/autoroute.list should be edited by
the TEDfax administrator to contain the list of user names to search for. Each
line in the file has the format:

User Name<tab>user@host

A sample line might be “John Smith<tab>jsmith@localhost”.

TEDfax converts the first page of each fax into ASCII text, then scans the
resulting text for the keyword “To:” followed by a user name or names. Note
that if the text “To: Smith” appeared, and “John Smith” and “Bob Smith”
appears in the file autoroute.list, the fax will be forwarded to both users. If the
autorouter cannot find the keyword “To:” or any of the names in autoroute.list,
it will leave the fax in the INBOUND directory to be manually routed
(forwarded) by the TEDfax administrator.

A log of successfully forwarded faxes is kept
in/var/dt/fax/autoroute/autoroute.log.

Autorouting is done through the shell script
“/var/dt/fax/autoroute/autoroute.csh”; edit this script to change the
behavior of the autorouter for your system.

The system must be running the Xerox/ScanWorX ICR engine,
/vat/dt/fax/autoroute/bin/icr_server.sun4, which is started at
boot time.

Note – Autorouting using character recognition is available only on sun4
architecture systems running SunOS 4.1.X.

Debugging ICR Autorouting

To debug ICR autorouting, you may step through the autoroute process by
hand to see how TEDfax is handling a given fax. You must be logged in as the
TEDfax administrator “root”, as only this user will be able to execute the ICR
engine.

Note – Autorouting using character recognition is available only on sun4
architecture systems running SunOS 4.1.X
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1. Login as “root” to the fax server host and do a “ps -axw” to verify that the
icr_server.sun4 process is running.

2. Select a fax whose first page you believe has valid routing information on it.

3. Convert the first page of the fax to text by running:
/var/dt/fax/autoroute/autoroute <path to fax> You may wish
to re-direct output to a file.

4. The output from autoroute is the text which the ICR engine was able to
extract from the document. If this text looks “sane” we should be able to use
it for routing information. If it doesn’t, routing won’t work. As a human you
can make this decision, but the software can only try...

If the ICR engine does not have a good success rate in recognizing the text,
try a larger point size and/or a different font in the To: field.

5. Pass the generated text into “faxrouter”, which attempts to match the text
against entries from the first column of
/var/dt/fax/autoroute/autoroute.list. If matches are found, the
second column (user@host) is output.

6. If any addresses (user@host’s) are found, the shell script (autoroute.csh)
would normally use TEDfax_forwardfax to forward the fax to the named
user. A copy is still kept in /usr/spool/TEDfax/inbound.

Modems

The TEDfax Modem Driver is has been tested with the following modems
listed in the table below.

Table 8-4 Supported Modems

AT&T Dataport Model 3710-A2-201.

Telebit WorldBlazer
Telebit QblazerPlus
Telebit T3000

PROM levels LA7.03 or higher (QB2.00 or higher for the
Qblazer). Check PROM level with the command “ATI3”.
Contact Telebit to update older PROM levels.

Everex 24/96D
Everex 24/96E

Everex 24/96D requires PROM levels released after 11/91.
Check PROM level with the command “(?)”.
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As the TEDfax Modem Driver customizes itself on the fly based on which one
of these modems it detects, it is unlikely that plugging in an unsupported
modem will work properly.

Developers may consult the section Modem SETUP Override if they wish to
attempt to get another Class 2 faxmodem to function with TEDfax.

▼ Modem Configuration

TEDfax must be told which modems to use for its operations, and how those
modems are to be configured. This is done by “installing” the modems into
TEDfax using the FaxAdmin Tool in the TEDfax application manager. The
FaxAdmin tool must be run as “root” in order to properly create, chown, and
configure the serial device files used by the modems.

1. Be sure to terminate any getty processes currently running on the device.

2. Run the FaxAdmin tool as the “root” user.

3. Press the “Add Modem” button.

4. Enter the desired name for the new modem, then <return>.

5. Enter the Area Code, Number, and other information (for the faxmodem’s
phoneline.

6. Enter the device name, (for example, /dev/cu0b or similar).

7. Enter the path of the unique queue directory to use or of the “shared queue”
if you are setting up a “modem pool.”

8. Click on “Save.”

Multitech 224BAF
Multitech 932BA
Multitech 1432BA
Multitech 1432MU

PROM levels released on or after 5/5/92. Check model
number with the command “ATI2”; the date will appear at
the end of the returned string. Ensure the dip switches on
the right side of the modem are set appropriately.

Supra Faxmodem v.32 Model V1.71-02 TR14-Jxxx-001 225 (ATI3)

BOCA M1440E Model V1.31-AS29 (from ATI2)

Practical Peripherals Model PM9600 FXMT

Table 8-4 Supported Modems
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The device will be chowned to root/binand will be usable only by TEDfax.
The TEDfax_serverd daemon must be running in order to recognize the new
modem. After adding a new modem, you may run “fax” as the user “root” and
restart the modem from the Modem Info screen.

▼ Modem Hardware Configuration

TEDfax usually uses hardware flow control; therefore, the serial cable
connecting to the modem must support hardware flow control. In general, the
cable should wire pins 2, 3, 4, 5, 6, 7, 8, and 20, for transmit data, receive data,
CTS, RTS, DSR, DCD, DTR, and signal ground, respectively.

If you are not using a Sun serial port (A or B), verify that the serial port you are
using supports hardware flow control. TEDfax has been successfully tested
with Aurora and Sun serial port extenders and some terminal servers. (On the
Sun ALM-2, use ports 00-04.) Table 0-4 lists TEDfax compatible modems.

Some modem over ride files can be used to force the modem driver to software
flow control. Refer to the section titled, Modem SETUP Files.

▼ Multitech DIP Switch Configuration

The Multitech faxmodem has a number of DIP switches on the right side.
Switch settings successfully tested at TriTeal Corporation are listed in the table
below.

Table 8-5 Multitech DIP Switch Configuration

Switch Up or Down Meaning

1 UP DTR acts “Normally”

2 UP Hardware Flow Control

3 DOWN Enable Response Codes

4 UP n/a

5 UP Auto answer enabled

6 UP Max Throughput On

7 UP RTS functions “Normally”
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▼ Modem SETUP Files

TEDfax features the ability for fax administrators to provide an external
“SETUP” file which may be used to over ride the internal modem setup
routine in the TEDfax_modem binary.

This allows programmers to override the modem switch settings used to
synchronize the fax modem. This is used by TriTeal Corporation when adding
support for new Class 2 fax modems.

In general, if the file “SETUP.<modemname>” is present in the spool directory
for the modem named <modemname> then the internal setup routine will be
replaced by the setup specified into the SETUP.<modename> file. For detailed
information on the contents and format of this file consult the files in the
directory /usr/dt/fax/utils/modem_override. This directory contains
SETUP.<modemtype> files for each of the support fax modems and a README
file.

Please note that this facility is documented for those advanced users who wish
to spend time working with their own fax modems or who have special setup
requirements for existing fax modems.

TriTeal Corporation does not provide modem porting services as part of the
basic support contract. Support only covers “supported” fax modems!

8 DOWN Enable Command Mode

9 DOWN n/a

10 UP Dialup Line

11 DOWN AT or MULTITECH responses

12 DOWN default setting is DOWN

13 UP 2400 bps operation

14 UP 2400 bps operation

15 UP CD & DSR “normal”

16 UP n/a

Table 8-5 Multitech DIP Switch Configuration

Switch Up or Down Meaning
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Using An Alternate Dialer Program

TEDfax provides administrators with the ability to replace or override the
internal dialer routine used by the TEDfax_modem binary when placing a fax
call to a remote fax machine.

Non-US phone systems, or phone systems which run through a special PBX,
will want to use this approach in order to prevent TEDfax from adding an
extra “long distance 1” to long distance telephone numbers.

Using an alternate dialer can also be used to give local sites more control over
their modem device. Adding an “ATM1” can, for example, be used to turn on
the modem speaker.

The source code for the default dialer routine is distributed in the directory
/usr/dt/fax/utils/dialer. A README and Makefile, along with the
source code and comments in the file TEDfax_dialer.c may be used to
install any number of alternate dialer routines. A step-by-step tutorial of this
process is included below.

The source code in the file
/usr/dt/fax/utils/dialer/simple_dialer.c may also be compiled
and installed in /usr/spool/TEDfax/Any/dialer.modem1 (or any other
modem’s spool directory/dialer.<modemname> file). The simple_dialer.c
routine simply glues any defined prefix string, the exact number entered by the
user to fax to, and any postfix string together to result in an AT command to
dial the specific number requested. It is ideal for sites in Europe or sites which
operate through special PBX systems.

To compile and install the simple dialer, change directories into
/usr/dt/fax/utils/dialer and type:

cc -DMAIN simple_dialer.c -o simple_dialer
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Copy the simple_dialer program in the correct spool directory for the
modem you are trying to replace the internal dialer routine for. Be sure to
rename the file correctly so it “takes over” for the internal routine. Specific
examples for various modems with different spool directories are listed in the
table below.

General Modem/Serial Port Information

TEDfax locks the baud rate between the modem and the serial line at 19200.
This is the minimum speed necessary to allow faxing to function properly.

TEDfax sets the serial port to operate using full hardware flow control signals.
This allows both the host and the faxmodem to control the flow of data.

In some cases, TEDfax can be set to use software flow control.    A series of
SETUP files are provided if you wish or need to use this facility. See files with
the word “SOFTWARE” in their name in
/usr/dt/fax/utils/modem_override.

Seamless Integration with WordPerfect 5.1

The following describes the process of seamlessly integrating WP 5.1 with
TEDfax so that jobs printed to an “TEDfax” printer from within WP will result
in an TEDfax “Send” window popping up with the postscript document pre-
attached.

The procedure is to setup a “Printer Port” for ’fax’ and then to define a
Passthru PostScript printer which points to this port. Consult the WordPerfect
Administration Manual for details. The following procedures were verified by
TriTeal Corporation for WordPerfect setup.

1. Login as root on the machine whose disks hold WordPerfect.

Table 8-6 Modems with Spool Directory Names

Modem-Name Defined Spool File Name To Use

modem1 Any /usr/spool/TEDfax/Any/dialer.modem1

modem2 Two /usr/spool/TEDfax/Two/dialer.modem2

modem3 Any /usr/spool/TEDfax/Any/dialer.modem3
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2. setenv WPTERM51 to the correct terminal type for the terminal you are using
(e.g. setenv WPTERM51 xterm)

3. Set your path to include the bin directory of your WordPerfect Installation
(e.g. set path = ($path /home/wp5.1/bin))

4. Run the “wpport” command.

5. Select “1” to Create a new Port.

6. Enter “fax” for the port name.

7. Define the header field as empty.

8. Define the trailer field as empty.

9. Define the command to run as:

/usr/dt/fax/bin/fax_fw <f> $DISPLAY

10. Use “0” to get back to the main menu.

11. Save the result to disk using “Save” and option 1.

12. Exit wpport.

13. Restart wpexc51.

wpexc51 -k

wpexc51

14. Run “xwp”.

15. From the “File” menu of the big window “Select Printer”.

16. Add A New Printer.

17. Select “Passthru PostScript” as the Type.

18. Setup the Printer.

19. Change name to “TEDfax” and SET PORT to “fax”.
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Coverpages

TEDfax coverpages are Postscript documents that may contain a set of known
macro strings TEDfax knows to look for and replace. The macros supply
“placeholders” in which information such as destination name and company,
etc., will appear. Coverpages are optional; faxes are not required to have them.

TEDfax allows you to create your own coverpages, either from within TEDfax
or using another application. In general, most one-page Postscript documents
may be used; however, users should keep in mind that complex Postscript
documents, such as those with complex graphics, can take a long time to
render.

PostScript files can contain EPS (Encapsulated PostScript) files, which for
example, might contain your company logo. Coverpages are rendered by
calling the render script from the TEDfax_modem daemon just before making a
phone call. This ensures that coverpages will be correctly time-stamped.

TEDfax is shipped with a default coverpage with the title “TEDfax” at the top
of the page, in /var/dt/fax/data/coverpage.ps. DO NOT MODIFY THIS
FILE as it is used by TEDfax when creating new coverpages.

Coverpage creation and installation can be done from the File menu of the
Send screen:

Create Coverpage... Create a new coverpage based on the default TEDfax
coverpage, but with your own company name and
information.

Customize Coverpages...Install or un-install an existing Postscript file from the
user’s list of available coverpages.

Using “Create Coverpage”

The “Create Coverpage...” feature of the Send screen’s File menu is used to
create simple coverpages based on TEDfax’s default coverpage.

You will be prompted for your company’s name and information; this will be
used to customize the new coverpage for your company.

This is a front end to the shell script new_coverpage, which copies
/var/dt/fax/data/coverpage.ps to a user defined file while substituting
the company name specified by the user for the word “TEDfax.”
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To create more complex coverpage designs, use a third-party application to
create a one page Postscript file. An example of using FrameMaker for such a
task is included in the section titled Coverpages from FrameMaker. Then use
“Customize Coverpages...” to install that file.

Using “Customize Coverpages”

The “Customize Coverpages...” feature of the Send screen’s File menu is used
to add existing Postscript files created from other applications to the user’s
menu of available coverpages (in the options panel of “Send”).

If you wish to add a new coverpage to the list of available coverpages, you
must first create the new coverpage, either using “Create Coverpage...”, or
using an external program to generate a PostScript file that contains the macro
strings used by TEDfax to render a coverpage.

Once the Postscript file has been created, use “Customize Coverpages...” to
add it to the list of available coverpages. Simply type the name you wish the
coverpage to have and the exact path and filename of the postscript file to be
used, then press the “Add” button.

The new coverpage will then be added to the user’s menu of available
coverpages, appearing in the Options view of the Send screen. To use your
coverpage on a fax, just select it from the menu. Be sure to press Save As
Defaults under the Options menu if you wish to use this new coverpage as
your default cover page.

Recognized Coverpage Macro Strings

Using macro strings within a Postscript coverpage, the user can specify
information, such as the destination’s name, that will change from fax to fax.

To use the macro strings, type them (in UPPERCASE) in the exact position,
size, font, etc. that you want their represented information to be. TEDfax will
search the Postscript file for the macro strings every time the coverpage is
rendered, and replace those strings with the information they represent.
Known macro strings are listed in the table below.

Table 8-7 Known Macro Strings

DATESTRING Replaced by the current date.
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Coverpages from FrameMaker

The following reviews the process of creating, editing, and installing a Custom
CoverPage using FrameMaker.

First, create a single page FrameMaker document which represents the cover
page you’d like to use. You can use the default coverpage for TEDfax,
distributed as a frame document in /usr/dt/fax/utils/coverpage.doc.
Feel free to import whatever graphics you would like into the page. On the
page, using a fixed size font, insert the “keyword strings” which will be
replaced each time a fax is generated (e.g.: FROMNAME).

Print the Frame document to a PostScript file using the Frame “Print”
pulldown and the Save To File option. For the purposes of the example, we’ll
call this file custom_coverpage.ps

Edit the saved file and re-join any of the “keyword strings” that FrameMaker
may have broken into multiple words. For example, Frame might turn the
word “FROMNAME” into something like:

(FROM) 117 567.01 T

(NAME) 117 552.01 T

FROMNAME Replaced by the From Name text field.

FROMORG Replaced by the From Company text field.

FROMVOICE Replaced by the From Voice Number text field.

FROMFAX Replaced by the From Fax Number text field.

TONAME Replaced by the To Name text field.

TOORG Replaced by the To Company text field.

TOVOICE Replace by the To Voice text field.

TOFAX Replaced by the To Fax text field.

TOSUBJECT Replaced by the text in the Subject text field.

PAGECOUNT Replaced by the number of included pages.

TEXT0 [...TEXT14] Replaced by the first 15 lines of the “Message” field.

Table 8-7 Known Macro Strings
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Your job is to join these using a text editor such as vi. In general, it’s okay to
merge these two components into the first component, deleting the latter
component. In the example above, you’d edit it into:

(FROMNAME) 117 567.01 T

Finally, having saved the edited file, go into TEDfax’s Send Module and use
the “File” pulldown to select the “Customize CoverPages” option. Enter a
name for the coverpage and the path to the file you’ve created and use the
“Add” button to add it to your database of Cover Pages.

Debugging Hints

Before calling Technical Support we ask that you take the time to step through
this debugging guide to verify that your problem and its solution is not
already documented in this TEDfax User’s Guide.

If you are still unable to resolve your problem, please feel free to call TriTeal
Corporation Technical Support at 1-800-TRI-TEAL. You can also send Email to
TEDfax@triteal.com, or fax to 619-930-2081, Attn: TEDfax support.

Debugging - File Ownership & Permissions

TEDfax is a complex package that can require a great deal of careful setup in
order to work properly. This debugging guide is included to assist fax
administrators in diagnosing some of the more common problems that
incorrect system setup can introduce to TEDfax. The table below lists common
debugging areas to inspect.

Table 8-8 Debugging Inspection Areas

/usr/dt/fax Verify that faxserver has an install direcory to /usr/dt/fax.
This directory contains the subdirectories Any, autoroute, bin,
data, doc, filters, g3, gsdir, gsfonts, inbound, lock, sbin, tmp,
and utils. All directories, including /usr/dt/fax, must be
owned by bin and have owner write permission.

/usr/spool/TED-
fax/lock

This subdirectory must have permission settings of
drwxrwxrwx (e.g. world writable).

/usr/dt/fax/.fa
xrc

The file must exist.
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Debugging - Is the Server Running

If the software appears to be properly installed and the permissions on the
directories and files are correct, the next thing to check is the existence of the
server daemon. Proceed as follows:

/var/dt/fax/dat
a

This directory must exist and be writable by bin. It must contain
the files coverpage.ps, drivers, faxdevices, and macros.

/usr/dt/fax/
filters/
fax_filter

This file must exist and be owned by root. It must run setuid to
root in order to allow faxing from “lpd”.
(-rwsr-xr-x and owned by root)

/usr/dt/fax/sbi
n/
TEDfax_serverd

This file must exist, be owned by bin and run setuid bin.
(-rwsr-xr-x and owned by bin)

/usr/dt/fax/sbi
n/
TEDfax_faxmaild

This file must exist, be owned by root and run setuid to root to
allow fax forwarding of faxes.
(-rwsr-xr-x and owned by root)

Table 8-9 Checking the Server Daemon

Checking Server Do a “telnet serverhost 1234” to connect to our faxserver man-
ually. A “connect: Connection refused” means that the fax-
server is not running on “serverhost”. You have to run
/usr/dt/fax/sbin/start_faxserverd on “serverhost”
to get things started.

Table 8-8 Debugging Inspection Areas
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Debugging - Is the Client Running

Run the GUI portion of the package:

Debugging - User Interface “looks” funny

If the user interface comes up but the background color of the windows is
white on a color display, it is possible that the correct Xdefaults have not been
read in.

Table 8-10 Checking the TEDfax GUI

Checking the
TEDfax GUI
(as the fax
administrator).

Login as root and run /usr/dt/fax/bin/fax or select the
“SendFax” icon from the Fax in the Application Manager.
The TEDfax should appear in color on your screen. If this is not
the case, then the application default resource file
(/usr/dt/fax/Fax.ad) was not read in or installed on your
current display.
If you do not have a .faxrc file in your home directory, the soft-
ware will notice and will ask you if its okay to create one. This
runs the script /usr/dt/fax/bin/new_faxrc. If you do not
have write permission to your home directory you could have
real problems. Further, the new_faxrc script is there to create a
.faxrc file for users, not fax administrators. It does not append
all the necessary keys to the file for the administrator. If you
damage the .faxrc file of the fax administrator, you should copy
/var/dt/fax/data/.faxrc to /usr/dt/fax/.faxrc to
recover.
Note that the environment variables
TEDfax_HOME and TEDfax_FAXRC will override the defaults
of /usr/dt/fax and /usr/dt/fax/.faxrc. If you are having trou-
ble, check to see that these environment variables are not mis-
directing you.

Table 8-11 Checking Button Strings

Menu buttons have
the wrong strings.

The file /usr/dt/appconfig/C/Fax may be corrupt. This
file defines the strings.
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Debugging - Status of The Modem Driver

The next aspect of the software is to check the status of the fax modem. Select
the “FaxQueue” icon from the Application Manager in the toolbox to open a
Queue module for modem1. Click on “Modem Info” to open a Modem Info
module. The following table lists some modem driver status debugging hints:

Debugging - Queuing from GUI & Sendfax

The next aspect of the software to check is the queuing of outbound faxes to
the outbound fax queue. The following lists some queueing debugging hints:

Table 8-12 Checking Modem Driver Status

Modem Status The Modem Status field displays the current status of the
TEDfax_modem process controlling the current modem. It should say
“Modem Ready” if all is well.

Terminate Click on the “Terminate” button. This should terminate the current
modem process. The status field should change to “Terminated.”

Restart Click on the “Restart” button to restart the faxmodem.
If the message “Terminated - device /dev/XXXX not owned by bin”
appears check the ownership of the device in question. It should be
owned by bin.
If the message “Terminated -- Failed to open /dev/XXXX” is dis-
played check the permissions of /dev/XXXX
(should be rwx------).
If the message “Trying to Setup Modem” alternates with “Failure To
Setup Modem” and “Hanging Up Modem” then something is wrong
with the link between the serial port and the faxmodem (or you have
an unsupported faxmodem plugged in). Check the sections on Pre-
Install Serial Port Configuration, Modem Hardware, Reserving a
Serial Port and Adding A Serial Port. Also check to see that no other
processes are currently using the serial port.
if the message “Modem Ready” or “Modem Ready [DEMO MODE]”
appear, the TEDfax_modem process is running and well.

Table 8-13 Checking the Queueing of Faxes

Getting Ready To test queuing of faxes open the Queues Module by selecting
the”FaxQueue” icon in the Application Manager.
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Debugging - Queuing from lpr & mail

To continue testing of fax queuing, you can try to queue a fax via UNIX mail
and UNIX lpr. The following lists some queuing from lpr and mail
debugging hints:

Queuing a Fax from
the GUI.

Click on the “SendFax” icon in the Application Manager. Try to
move the “Send” window so you still have a view of the
“Queue” window. Type in a name, company, voice number
and the fax number of a fax machine. Enter a text message into
the “Message” field and click on “Send Fax”.
Otherwise, the fax should queue to the server. Shortly after you
click on “Send Fax” the Queue Module should be updated to
include an entry for your fax request.

Queuing a fax from
the command line
“sendfax” program.

To send a fax from the command line use sendfax:
sendfax -f /etc/motd -n “Bob Smith” -o “Bob Co” -p
“555 1212”
Shortly after entering the line above, the fax should appear in
the outbound queue. Any errors which occur will print to stan-
dard output.

Table 8-14 Checking the Printer and Mail

Getting Ready To test queuing of faxes, open the Queues Module by clicking
on “FaxQueue” icon in the Application Manager.

Sending a fax from
UNIX mail

You should also be able to get a fax to appear in the outbound
fax queue using UNIX mail. Use the line
mail fax -s “Test Name, Test Org, 5551212”
followed by a brief fax message to queue a fax via Email. If an
error occurs you will receive Email indicating its nature.

Send a fax from
UNIX lpr

Type in a line like the one below to queue a fax of your local
/etc/motd file to your fax machine:
lpr -Pfax -J”Name, Company, 5551212” /etc/motd
If an error occurs, you’ll receive Email describing the nature of
the problem.

Table 8-13 Checking the Queueing of Faxes
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Debugging - Modem Fails to Transmit or Receive a Fax

If fax jobs are showing in the fax queue, but are never draining from the queue,
the TEDfax_modem process is failing to transmit the fax. The fax administrator
should focus attention on this single portion of the TEDfax package. The
following information may be useful in finding a pointer to the actual problem:

Table 8-15 Checking Modem Transmission/Receiving

TEDfax_modem run-
ning?

Do a ‘ps -axw’ on the server host and verify that an
TEDfax_modem process is running for the modem. If one isn’t
running, use the “Restart” button in the Modem Info Screen to
restart the modem.

Check the logfile Check the logfiles in the spool directory for the modem. For
modem1 this is /usr/spool/TEDfax/Any/log-
file.modem1

Create a debug file
and restart the
modem process.

TEDfax will store detailed TEDfax_modem information if the
fax administrator creates a debug file in the spool directory for
a modem. The TEDfax_modem software will check for this file
periodically and, if it exists, dump debug information of all
modem commands and modem responses (e.g.: “AT”’s and
“OK”s get logged to this file)
touch /usr/spool/TEDfax/Any/DEBUG.modem1
try to send or receive a fax
(wait 30-40 seconds)
tail -f /usr/spool/TEDfax/Any/DEBUG.modem1
You can Email this file and brief comments describing the
problem to TriTeal Corporation (TEDfax@triteal.com) for help
in diagnosing problems.
Be sure to DELETE this file when you’re done.

Modem driver
works but fails to cor-
rectly dial.

The built in dialer of TEDfax_modem may not be sufficient to
handle dialing on phone lines running through PBX’s and the
like. Often this is the problem when the software is repeatedly
unable to send a fax.
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Debugging - Failure to Image Properly

If an attached document does not image correctly the following steps may be
taken to identify the nature of the problem:

Table 8-16 Checking Document Imaging

Test through GUI
attach

Run ‘/usr/dt/fax/bin/fax -qf <filename>’ and use the
File Menu’s “Preview” button to verify that <filename> is
imaging properly.
In the case of a document rendering properly through the GUI
but failing to render through another portion of TEDfax (e.g.:
lpr interface), the trouble is probably not the render engine.
If the document fails to render, be sure to check for messages in
the window you ran “fax -qf” in. These may be helpful in
debugging.

Check File Type Do a “file <filename>” to see what UNIX thinks the file is. The
base distribution assumes the file to be ASCII Text, PostScript,
Sun Rastor, FrameMaker or TIFF. TIFF show up in the default
‘file’ command as “data” but will shows up as a TIFF file in the
GUI attachment window.
If the type returned from “file” does not exist as a case state-
ment in the “render” script then <filename> will be rendered
as ASCII Text. You can try rendering the file using alternate
‘case’ types by running:
/usr/dt/fax/bin/render “<type>” <filename> x <out-
put>

Send Email Copy to
TriTeal Corporation

If the image still does not render, and there are no output error
messages, please Email a copy of the file to TriTeal Corporation
(support@triteal.com) with brief comments describing the
problem. Any file type other than ASCII or PostScript should
be compressed (if larger than 100K) and uuencoded before
Emailing it.
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Appendix A- Testing and Adding

PostScript Heuristics for Extracting
Embedded Router Commands

As explained in Chapter 8, PostScript documents fed to TEDfax through the lpr
or lp interfaces will attempt to see if there are any embedded router commands
on the first page of the PostScript document.   This is done by attempting to
extract the ASCII text of the first page of the document using the shell script
/usr/dt/fax/gsdir/pstotext.sh

As most PostScript generating applications generate their postscript
consistently, it is usually the case that once a suitable heuristic is found for a
test file generated by a particular application’s PostScript engine, that all
documents generated by that engine will be properly converted by the same
heuristic.

As most applications also place an application-specific “%%Creator” line at the
top of the PostScript file, it is fairly easy to modify the pstotext.sh script to
execute a specific postscript-to-text conversion heuristic for files which come
from the same “Creator.”

To debug pstotext conversion you should create a test document and save it as
a PostScript file to your UNIX workstation. Then do the following to see how
pstotext processes the file:

cd /usr/dt/fax/gsdir

setenv TEDfax_HOME /usr/dt/fax
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pstotext.sh /tmp/myfile.ps > /tmp/myfile-as-text

Then take a look at the file /tmp/myfile-as-text and see what
pstotext.sh was able to make of it.

If the text output was not present, or the text was 'garbled' you can try our
secondary heuristic by adding lines like the ones already present in
pstotext.sh for “APPLE” and “NEXT” PostScript output. See the file
“pstotext.sh” for details.

Finally, if our second heuristic doesn't work, you can always write one of your
own by looking at the PostScript file and determining how to extract its text.
If you extend pstotext.sh to handle a new PostScript file type, the entire
TEDfax package will be able to take advantage of your extension as all
PostScript-to-text conversions are run through pstotext.sh.

If you do add a new extension, please send a copy to support@triteal.com so
that other TEDfax users can benefit as well.
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